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1. INTRODUCTION 

1.1 Objectives and Scope of the Database 

REFPROP is an acronym for REFerence fluid PROPerties.  This program, developed by the National 
Institute of Standards and Technology (NIST), calculates the thermodynamic and transport properties of 
industrially important fluids and their mixtures.  These properties can be displayed in tables and plots through 
the graphical user interface; they are also accessible through spreadsheets or user-written applications 
accessing the REFPROP DLL or the FORTRAN property subroutines. 

REFPROP is based on the most accurate pure fluid and mixture models currently available.  It implements 
three models for the thermodynamic properties of pure fluids:  equations of state explicit in Helmholtz energy, 
the modified Benedict-Webb-Rubin equation of state, and an extended corresponding states (ECS) model.  
Mixture calculations employ a model that applies mixing rules to the Helmholtz energy of the mixture 
components; it uses a departure function to account for the departure from ideal mixing.  Viscosity and 
thermal conductivity are modeled with either fluid-specific correlations, an ECS method, or in some cases the 
friction theory method. 

These models are implemented in a suite of FORTRAN subroutines. They are written in a structured format, 
are internally documented with extensive comments, and have been tested on a variety of compilers. 
Routines are provided to calculate thermodynamic and transport properties at a given (T,ρ,x) state. Iterative 
routines provide saturation properties for a specified (T,x) or (P,x) state. Flash calculations describe single- 
or two-phase states given a wide variety of input combinations [(P,h,x), (P,T,x), etc].  

A separate graphical user interface, designed for the Windows operating system, provides a convenient 
means of accessing the models. It generates tables and plots for user-specified mixtures or a number of 
predefined mixtures (air, the commercially available refrigerant blends, and several reference natural gases). 
A help system provides information on how to use the program. Information screens that display fluid 
constants and documentation for the property models can be called up at any time. Numerous options to 
customize the output are available as well as capabilities to copy and paste to and from other applications. 

The property models can also be accessed by other applications (such as spreadsheets) through use of a 
dynamic link library (DLL). 

1.2 Uncertainties in Calculated Properties 

Our objective in selecting property models for use in REFPROP was to implement the most accurate models 
currently available. The user should be aware that the uncertainties in these models vary considerably, 
depending on the fluid, property, and thermodynamic state. It is thus impossible to give a simple, global 
statement of uncertainties. Even for the most-studied fluids with equations of state based on accurate, wide-
ranging data, uncertainties are complicated functions of the temperature and pressure. The interested user is 
referred to the original literature sources for details. (References to the literature are accessible through the 
fluid and mixture information screens described in Sections 4.5.1 and 4.6.) 

The user is further cautioned that, by the very nature of a calculational program, property data are often 
displayed with more digits than can be justified based on the accuracy of the property models or the 
uncertainties in the experimental data to which the models were fitted.  

1.3 Organization of the User's Guide 

Section 2 details the installation procedure. Section 3 presents a brief overview of the structure of the 
program and its main features. Sections 4 through 11 describe the features of the program in detail. The 
fluids in the database are tabulated in Appendix A. Use of the FORTRAN property subroutines is described 
in Appendix B. Use of the property routines with Excel spreadsheets and Visual Basic programs is outlined in 
Appendix B. Appendix C lists support contacts at NIST. 
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2. INSTALLATION 

2.1 System Requirements 

REFPROP is designed to run on any personal computer running the Microsoft® Windows® 98, 2000, XP, 
Vista, or similar operating system. The program requires 20 MB of hard disk space. 

2.2 Installation 

Place the REFPROP CD-ROM in the CD drive. Click [START], select [RUN] type in: D:\NIST2309, or 
whichever driver letter is associated with your CD reader. Follow the remainder of the installation 
instructions.  By default, REFPROP is installed in the C:\Program Files\REFPROP directory, but this can be 
changed by the user at installation.  The user is cautioned to not change the names of the various files and 
subdirectories that are installed. 
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3. OVERVIEW 

This section presents a brief overview of the program and its main features. Please refer to the remaining 
sections in this User's Guide for more complete information. 

3.1 Database Structure 

REFPROP consists of a graphical user interface (GUI) and FORTRAN subroutines implementing a variety of 
fluid property models. The interface provides a convenient means to calculate and display thermodynamic 
and transport properties of pure fluids and mixtures. The property models are written in FORTRAN and 
accessed by the GUI through a dynamic link library (DLL). The property subroutines can also be used by 
other applications, such as spreadsheets, independently of the GUI, as described in Appendix B. 

The high-level subroutines that carry out iterative saturation and flash calculations are independent of the 
fluid property models. Underlying these subroutines are sets of core routines for each of the models 
implemented in the program. The numerical coefficients to the property models for each fluid are stored in 
separate text files. The coefficients for the mixture departure functions are stored in a single text file. 
Additional files contain information specifying predefined or user-defined mixtures. This structure simplifies 
the addition of new fluids and additional models to future versions of the database and makes such additions 
almost totally transparent to the user. 

3.2 Use of the Database 

Start the REFPROP program by double-clicking on its icon. A banner screen displays the title, credits, and a 
legal disclaimer. Clicking the "Information" button calls up further details and credits through the help system. 
Clicking the "Continue" button starts the program. The program is controlled, in the usual fashion of a 
Windows application, by the use of pull-down menus displayed across the top of the application window. 

 

3.3 Overview of the Menus 

The File menu provides commands to save and print generated tables and plots. Individual items or entire 
sessions with multiple windows can be saved or recalled. The standard Print, Print Setup, and Exit 
commands are also present. 
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The Edit menu provides copy and paste commands, which allow selected data or plots to be exchanged with 
other applications.  

The Options menu provides commands for selecting the unit system, properties of interest, the reference 
state, and user preferences. These options can be stored for recall. A user-defined set of preferences is 
loaded upon program startup. 

The pure fluid or mixture of interest is specified with commands in the Substance menu. Most refrigerant 
mixtures of current commercial interest (those having an ASHRAE R400- or R500-series designation) are 
predefined. Standard air and five mixtures of interest to the natural gas industry are also predefined. In 
addition, new mixtures with up to 20 components can be specified and saved. 

The Calculate menu initiates the calculations that generate a property table. Each property selected for 
display is shown in a separate column of the table. Two types of tables are provided. The first provides 
properties either at saturation or with a property (such as density or enthalpy) held constant with temperature 
or pressure varying over a specified range. The second allows the user to select the independent variables. 
Values of the independent variables can be entered with the keyboard, read from a file, or pasted from 
another application.  

The Plot menu provides x-y plots of properties appearing in a table. In addition, simple plots of the 
thermodynamic surface can be easily generated over a wide range of coordinates, including temperature-
entropy and pressure-enthalpy. Temperature-composition and pressure-composition diagrams for binary 
mixtures can be generated automatically. Commands are provided to modify the plot size, axis scaling, plot 
symbols, line type, legend, and other plot features.  

Each table or plot appears in a separate window and can be accessed, resized, or retitled with commands in 
the Window menu. The number of windows is limited only by available memory.  

A complete help system can be accessed through the Help menu.  

A status line at the bottom of the screen displays the currently specified fluid or mixture, composition, and 
reference state. Clicking on the status line (or the Substance/Fluid Information command) calls up 
information screen(s) for the mixture and each of the components, thereby providing documentation for fluid 
constants, the source of the models, equation of state uncertainties, and their range of applicability. 

The menus and dialogs are typically navigated with the mouse. Keyboard shortcuts are also available for 
virtually all actions. These are activated by the "Alt" key in combination with the underlined letter of the 
individual command. The TAB key moves between items in a dialog. 

3.4 Cautions 

Users of the REFPROP program should be aware of several potential pitfalls: 

If you experience large differences in your expected values of enthalpy or entropy as compared to those 
calculated by the program, see information on reference states (Section 7.2) 

Changing the units in the Options/Units menu applies only for new tables and plots; it does not change the 
units on the tables already created. 

The equation parameters for mixtures composed of natural gas fluids come from the 2008 GERG model (see 
preferences in Section 7.5 for the reference).  The default pure fluid equations of state in REFPROP are not 
the same as those used in the GERG model, rather they are more complex with lower uncertainties.  The 
GERG equations for the pure fluids are shorter, less complex, and faster, but slightly less accurate.  To use 
the GERG model, as published, choose the corresponding option under Options/Preferences.  The 
preference screen also has an option to use the AGA8 model for natural gas calculations. 
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The NIST REFPROP program is designed to provide the most accurate thermophysical properties currently 
available for pure fluids and their mixtures. The present version is limited to vapor-liquid equilibrium (VLE) 
only and does not address liquid-liquid equilibrium (LLE), vapor-liquid-liquid equilibrium (VLLE) or other 
complex forms of phase equilibrium.  The program does not know the location of the freezing line for 
mixtures.  Certain mixtures can potentially enter into these areas without giving warnings to the user. 

Some mixtures have components with a wide range of volatilities (i.e., large differences in boiling points), as 
indicated by a critical temperature ratio greater than 2.  Certain calculations, especially saturation 
calculations, may fail without generating warnings.  Plotting the calculation results may reveal such cases–
looking for discontinuities in density is a good check.  Such mixtures, including many with hydrogen, helium, 
or water, may not have Type I critical behavior, that is they do not have a continuous critical line from one 
pure component to the other.   The estimated critical parameters specified in the Substance/Fluid Information 
screen for these types of mixtures will not be displayed. 

There are cases where an input state point can result in two separate valid states.  The most common is 
temperature-enthalpy inputs.  Viewing a T-H diagram will help show how there can be two valid states points 
for a given input.  For example, nitrogen at 140 K and 1000 J/mol can exist at 6.85 MPa and at 60.87 MPa.  
When this situation occurs, REFPROP returns the state with the higher density.  See the Specified State 
Points section for information on calculating the upper and lower roots. 

There are certain properties pertaining only to the saturation line, such as dp/dT.  For most cases, displayed 
properties at saturation states are those for the single phase on the saturation boundary.  Thus, derivative 
properties at saturation as well as saturation properties that are given along constant property paths, such as 
Cv, Cp, or Csat, pertain to their state in the single phase.  Those properties label with a '[sat]' indicate a path 
along the saturation line. 

For pure fluids, when the 'Show 2-phase' option in the plot menu is selected, the generated lines for pressure 
and temperature represent metastable fluid states and the calculated lines between them.  These are 
calculations from the equation of state disregarding any saturation states and generally have no physical 
significance. 

Two equations of state are available for hydrogen to account for the different quantum spin states of the 
molecule.  Normal hydrogen should be used in applications where it was created and stored at 250 K or 
above, or when it was cooled to below 250 K and stored without a catalyst for less than a day. The 
parahydrogen equation should be used where hydrogen was catalyzed or stored for several days at the 
normal boiling point (NBP) and used at any temperature within 1 day of storage at the NBP.  Since the rate 
of conversion between quantum states is dependent on temperature, pressure, and the storage container, 
these values are only estimates.  For more information, see the Leachman et al. literature reference in the 
Fluid Information window for hydrogen. 
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4. DEFINING THE FLUID OF INTEREST 
(The Substance Menu) 

The Substance menu defines the fluid or mixture for subsequent property calculations. Predefined mixtures 
can be selected or new mixtures of up to 20 components can be defined. Defining a new fluid or mixture has 
no effect on tables or plots already produced. 

4.1 Selecting a Pure Fluid 

Selecting the Pure Fluid item in the Substance menu brings up the dialog box shown below.  By default, only 
the more commonly used fluids are displayed; use the Specify Fluid Set command to modify the displayed 
list of fluids.  The available fluids are shown in a scrollable list on the left. (The fluids available in the program 
are also tabulated in Appendix A.) Select the fluid you want to investigate by clicking the mouse button on 
the fluid name. You can jump quickly to a fluid by typing the beginning letter(s) of its name. Clicking on the 
Info button brings up an information screen of fluid constants (such as molar mass and normal boiling point) 
and reference information. The information screen is described in more detail in Section 4.5.1. By clicking the 
OK button, all subsequent property calculations are carried out on the selected fluid. If you want to retain the 
previous fluid choice, click the Cancel button. 

If a fluid set has been specified (see section 4.4.3), then the "All fluids" button will display all of the fluids 
available, not just those in the specified set.  The pure fluids can be sorted by short name (or nickname), full 
name, CAS number, chemical formula, synonym, or UN number.  This is useful for fluids such as acetone, 
which is also known as propanone, where the name known to the user may not be listed in one of the 
categories. 

 

 

4.2 Selecting a Pseudo Pure Fluid 

The Pseudo Pure Fluid dialog lists all of the mixtures that are available as pseudo pure fluids.  Select the 
fluid you want to use by clicking on the fluid name.  The properties that are calculated for pseudo pure fluids 
are based on equations of state that have been developed solely for a specific composition.  The properties 
calculated for pseudo-pure fluids are generally valid only for single-phase states (including at saturation); 
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coexisting liquid and vapor compositions are not computed.  Click the Info button to display the Fluid 
Information dialog, which provides critical constants and other property information for the selected fluid. 

These calculations are generally based on mixture models that were fit to a wide variety of properties at 
various compositions.  The uncertainties of the pseudo pure fluid equations are often higher than the 
corresponding mixture model.  However, the calculational speed will be much faster, especially for saturation 
properties. 

 

4.3 Selecting a Predefined Mixture 

Predefined mixtures are specified in a way analogous to that for pure fluids by selecting the Predefined 
Mixture item in the Substance menu. The predefined mixtures include dry air and a number of commercially 
available refrigerant blends. These include the refrigerant blends defined in ASHRAE Standard 34, and 
several standard natural gas blends. Additional mixtures can be added to this dialog by saving a mixture in 
the Define New Mixture dialog described in Section 4.4. One significant difference between the Pure Fluid 
and Predefined Mixture dialogs is the effect of the Info button. Clicking the Info button here brings up a 
Mixture Information screen as described in Section 4.5.3.  

 

4.4 Defining a New Mixture 

The Define New Mixture item in the Substance menu brings up the dialog shown below and allows 
specification of a mixture of up to 20 components. Note that not all mixtures are allowed. The scrollable list 
on the left shows the available pure fluids. A mixture is composed by clicking on a fluid name to select it and 
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then clicking the Add button (or simply double-click the fluid name) to add it to the list of mixture components 
on the right. To remove a component from the mixture, click its name to highlight it and click the Remove 
button (or simply double-click). Note that when a fluid is added to the list on the right, it disappears from the 
list of available pure fluids on the left; this prevents inadvertently defining a mixture composed of two 
identical components. The pure fluid information screen for any component can be called up by selecting a 
fluid name and clicking the Info button. 

 

In addition, multiple selections can be made by either holding down the Ctrl key while selecting multiple 
fluids, or by holding down the Shift key to mark all fluids between the currently marked fluid and the selected 
one.  You can also use the arrow keys to select a fluid, and press Alt-A to add it.  The period and ">" keys 
will also add a fluid.  Removing the fluid can be done with either Alt-R, a comma, or "<".  Fluids can be 
highlighted by typing in the first few letters of their names; for example, typing "pr" will select propane; to get 
propylene, type "propy". 

These alternate ways of adding fluids make it easier to find and select a fluid.  For example, defining a 
mixture of R32, R125, R134a, and propane is quickest by typing the following sequence:  "r3.r125.r134.pr."  
If a wrong letter or number is entered, use the backspace button.  For instance, if "r124" is entered instead of 
"r125", press the backspace and then a "5", and the program will jump to R125. 

4.4.1 Defining the mixture name and composition 

The Specify Mixture Composition dialog shown below serves two purposes. First, it provides a means of 
specifying the composition of a fluid system consisting of more than one component. The second function 
provides an opportunity to store the fluid system so that it can later be selected with the Predefined Mixture 
command (as described in Section 4.3). 

Clicking the OK button in the Define Mixture dialog brings up the Specify Mixture Composition dialog. The 
name given to the mixture defaults to a concatenation of the component names; this can be changed by 
typing any desired name into the edit box at the top of the dialog. The mixture composition is entered by 
typing the desired values into the edit boxes next to the component names. The composition can be 
specified in terms of either mass or mole fractions. The basis for the composition (mass or molar) 
corresponds to the basis specified in the Units dialog (see Section 7.1). Composition in the other basis can 
be entered by clicking the pull-down arrow and selecting either "Mass Fraction" or "Mole Fraction". Clicking 
the name of a component brings up the pure fluid information screen for that component. 
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The mass or mole fractions must be entered for each component and must sum to 1 (or 100 if percentages 
are used) if the "Normalize compositions to one" checkbox is not selected.  If the "Normalize compositions to 
one" checkbox is selected, the value of each mass or mole fraction is set to the entered value divided by the 
sum of the values.  This option is most convenient if you want to specify the composition of a mixture by 
specifying the mass of each component. 

The Add or Remove Fluid buttons allow you to enter or delete fluids in the list without having to start back at 
the Define New Mixture dialog.  The Add Fluid button will bring up the pure fluid list and the desired 
component should be selected.  To remove a fluid, put the cursor in the composition box for that fluid and 
press the Remove Fluid button.  You will be prompted for confirmation before the fluid is removed. 

The Copy button places the fluid names and compositions (separated by tabs) onto the clipboard so that 
they can be pasted into other applications.  The Paste button will paste the values that are on the clipboard 
into the composition boxes.  The paste function is smart enough to search through multiple columns in the 
information stored on the clipboard for a column that contains numbers that sum to 1.  For example, the copy 
button pastes both the fluid names and compositions to the clipboard.  If the paste button is then pressed, 
the program realizes that the first column does not contain compositions and will paste the second column 
into the composition boxes. 

 

4.4.2 Storing a mixture for future use 

The Store button in the Specify Mixture Composition dialog allows you to store a mixture for future use. 
Clicking this button brings up a standard Windows file dialog. A new file containing the data necessary to 
specify the current mixture is placed in the Mixtures subdirectory of the working REFPROP directory. This 
new mixture is then available for future calculations directly from the Predefined Mixture dialog. Note that the 
mixture is identified by its name, not the name of the file storing its specification data. You can store a 
mixture at a later time by calling up the Specify Composition dialog and going directly to the Store dialog. 
You can edit the filename or change its location, but the interface recognizes only the files in the Mixtures 
subdirectory having a ".mix" file name extension. 

4.4.3 Specifying a fluid set 

With the increase in the number of fluids contained in REFPROP, it is often desirable to select only a certain 
number of fluids that you are interested in.  This is done through the Specify Fluid Set dialog.  Six default 
sets are available, and can be changed by the user to match their own preferences.  To use one of the six 
sets, simply click on it and press OK.   
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To enter a new set, press the Add New Set button and enter a descriptive name.  The Rename button allows 
you to rename a file set, and the Delete Set button allows you to delete the set.  To specify which fluids are 
in the set, press the Edit Set button and enter/delete fluids in a manner similar to that in the Define New 
Mixture dialog. 

The set labeled "calibration fluids" contains those fluids that generally have both high accuracy equations of 
state and transport equations.  The user should consult the Fluid Information screen to determine what the 
actual uncertainties in the equations are. 

The sets are saved to the hard drive once you press OK.  There is no need to save the options to keep the 
changes just made. 

4.5 The Status Bar 

A status bar at the bottom of the main window displays information about the current settings: 

the fluid or mixture name, 

the components of a mixture, 

the mixture composition (if applicable); if a mass basis has been selected (under the Units option) 
the composition is expressed in mass percentages, e.g. (50/50), in accordance with ASHRAE 
Standard 34; if a molar basis has been selected, the composition is expressed in mole fractions, e.g. 
(0.50/0.50), and 

the reference state for enthalpy and entropy calculations (see Section 7.2). 

If the settings for the front most table or plot window displayed differ from the current settings, the information 
for that window is also displayed following the current settings information as shown below. 

 

4.5.1 Pure-fluid information screen 

Clicking the status bar when a pure fluid is selected brings up an information screen. This screen is also 
displayed when a component name is clicked on the mixture information screen, the Specify New Mixture 
dialog, or the Specify Mixture Composition dialog. It can also be accessed through the Fluid Information 
command in the Substance menu. 
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The top border of the screen gives the short name for the fluid, its full chemical name (if different from the 
short name), chemical formula, and its Chemical Abstracts Service (CAS) registry number. The top half of 
the screen displays fluid constants—the molar mass, the triple point and normal boiling point temperatures, 
the critical parameters, and the acentric factor. These are displayed in units corresponding to the current set 
as specified in the Units dialog (Section 7.1). Also displayed is the dipole moment; for those fluids with a 
temperature-dependent dipole moment, the value at the normal boiling point temperature is displayed. The 
number of digits displayed corresponds to that set in the preferences (Section 7.5). 

The bottom portion of the info screen provides information on the models used to calculate the various 
properties. Information on the equation of state and the viscosity, thermal conductivity, surface tension, 
melting line, and sublimation line models can be called up by clicking on the buttons near the bottom of the 
screen. (Note that melting and sublimation lines are not available for all fluids.) The "equation of state" refers 
to a property model used to calculate all of the thermodynamic properties, including density, vapor pressure, 
enthalpy, entropy, heat capacity, and speed of sound. The temperature, pressure, and density ranges over 
which the selected model is applicable are displayed in the top portion of the dialog. Below that a one-line 
description of the model is given. Finally, a literature reference, along with a statement of the uncertainties in 
the equation of state, is provided in a scroll box. The reference information can be copied to the Clipboard by 
highlighting the desired portions with the mouse and clicking the Copy button. The Copy All button will 
generate a listing of all information included in the Information Screen.  Buttons near the bottom of the info 
screen call up similar information for each of the property models.  Click the OK button to return to the 
previous window or dialog. 

4.5.2 Changing property models 

For some fluids, more than one model may be available for some of the properties. If multiple models are 
available, the list box arrow to the right of the one-line model description is active; click this arrow to display 
the available models. The recommended model is identified with the term "NIST rec." Additional (alternative) 
models are identified with the term "Alt. model." Select the model to be used in subsequent calculations by 
clicking on its name. This option should be used with caution. In most cases, the NIST-recommended model 
should be used. The main purpose of this option is to allow comparisons with models used in earlier versions 
of the NIST databases. Note that alternative models are not stored with other preferences (see Sections 7.6 
and 8.1), so it would be necessary to specify an alternative model each time REFPROP is started. 
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4.5.3 Mixture information screen 

Clicking the status bar when a mixture has been selected brings up the Mixture Information screen. This 
screen displays the name of the current mixture at the top of the screen. The estimated critical parameters 
and molar mass for the specified composition are displayed. The "estimated critical parameters" may differ 
significantly from the true mixture critical parameters depending on the system. The components and their 
compositions are listed in the bottom part of the info screen. Clicking on a component name calls up the pure 
fluid info screen for that component. The basis for the composition (mass or molar) corresponds to the basis 
specified in the Units dialog. Composition in the other basis can be viewed by clicking the pull-down arrow 
and choosing either "Mass Fraction" or "Mole Fraction". Clicking the OK button returns you to the underlying 
window or dialog. 

 

4.6 Viewing Mixture Parameters 

The View Mixing Parameters dialog displays the numerical values of the parameters used in calculating 
mixture thermodynamic properties and gives information on the data sources. This command is active only if 
a mixture is specified. 
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The program calculates mixture properties by applying thermodynamic transformations to the Helmholtz 
energy. The mixture Helmholtz energy is calculated from the pure-fluid Helmholtz energies through the use 
of mixing rules.  The mixing rules are applied to binary pairs of fluids, so for mixtures with three or more 
components the binary pair of interest must be specified by clicking the check boxes next to the component 
names. 

The shorthand name of the mixing rule is displayed at the top right of the dialog. Below that are the 
numerical values for the parameters associated with that rule. The scroll box at the bottom of the dialog gives 
reference information. More complete information on the mixing rule can be obtained in the literature 
reference given in the bottom half of the scroll box. The reference information can be copied to the Clipboard 
by highlighting the desired portions with the mouse and clicking the Copy button. Click the OK button to 
return to the main REFPROP window. 

4.7 Changing Mixture Parameters 

The View Mixing Parameters option also allows changing the numerical values of the mixture parameters 
used in calculating mixture thermodynamic properties. In some cases, it may be possible to improve the 
agreement between the calculated values and experimental data by altering these values. This command is 
not intended for the casual user, and great care must be used in altering these values. 

Select the binary pair of interest as described in the previous section. The recommended mixing rule is 
displayed at the upper right of the dialog. The numerical parameters for that rule are displayed below in edit 
boxes; type in new values for any you wish to change. Changes take effect only when the Apply button is 
clicked and only for the given binary pair. Each binary pair in a multicomponent mixture must be edited and 
"Applied" separately. (Note that when you click the Apply button the mixture-specific reference information in 
the bottom part of the screen is replaced by the message "Binary parameters for this binary pair have been 
modified from their original values.") 

It is also possible to change the mixing rule. The available mixing rules can be viewed by clicking on the 
drop-down arrow. An alternate rule can be chosen by clicking on it. When a different rule is chosen, the 
parameters associated with that rule are set to default values approximating ideal mixing. New values for 
these parameters can be entered as described above. 

Clicking the Reset button resets all the mixing rules and their numerical parameters to the values originally 
read from the data file. 
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5. GENERATING PROPERTY TABLES 
(The Calculate Menu) 

The Calculate menu provides several options for generating tables of two distinct types. The Saturation 
Tables and Iso-Property Tables options calculate properties at even spacing of temperature, pressure, 
density, composition, or quality at some fixed value of another property. The remaining options bring up 
spreadsheet-type windows that allow arbitrary values of the independent variables (including composition) to 
be entered in a variety of ways. 

5.1 Calculating Saturation Tables 

Selecting the Saturation Tables option in the Calculate menu brings up a dialog box from which the form of 
the table is specified. There are numerous options for saturation tables, especially for mixtures. Saturation 
tables display properties for the saturated liquid and saturated vapor, denoted by (Liquid Phase) and (Vapor 
Phase) in the table headings.  

 

The composition basis for the calculations is specified by the left set of radio buttons. The independent 
variable is specified by the right set of buttons. Choose one button from each list. A small phase diagram 
depicts the type of calculation to be performed; this diagram changes as different buttons in the two lists are 
chosen. The red and blue dots indicate the points to be calculated, and the gray lines connect liquid and 
vapor points that are displayed in a given row of a table.  

Care should be exercised in selecting the desired composition basis. The liquid and vapor can be of the 
same composition, in which case the temperature or pressure of the liquid and vapor phases are not in 
equilibrium; this option is useful when working with a mixture of fixed composition. Alternately, the liquid and 
vapor can be in equilibrium with the specified composition set to either liquid at the bubble point or vapor at 
the dew point. In these cases, the temperature and pressure of the two phases are the same, but the 
compositions are different (except for the special case of an azeotrope).  

Six choices are available for the property to be varied (right-hand set of radio buttons). The first four generate 
points at the composition of the mixture; the last two calculate properties at different compositions that have 
no connection to the composition specified when the system was set up.  

For a pure fluid, not all of the mixture choices are meaningful, and a simpler dialog is displayed. In addition to 
the normal vapor-liquid saturation, for some fluids solid-liquid saturation (melting line) and/or solid-vapor 
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saturation (sublimation line) properties are available. These options are disabled for fluids lacking equations 
for the melting and/or sublimation lines. 

 

From either the mixture or pure fluid dialog, clicking the OK button brings up a dialog in which the range and 
increment of the property to be varied and the value of the property to be held constant (if applicable) are 
entered. Default values are provided. The first time a table is calculated for a specific fluid, the defaults are 
based on the current units settings and the properties of the fluid or mixture. For subsequent calculations, the 
default values for the range and increment are those from the previous table. The range and increment revert 
to default values when a new fluid or mixture is specified. Deselecting the "Reset bounds..." option under 
Preferences retains the range and increment; see Section 7.5. 

 

The "Leave active" check box at the lower left keeps this dialog as the top window on the screen, allowing 
rapid calculation of a series of tables of the same type. 

If the composition of the mixture is to be varied, the following window will appear: 
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The constant property (temperature or pressure) is entered at the upper left.  The composition will be linearly 
varied from the condition indicated in the "Initial" column to that in the "Final" column using the number of 
points indicated at the upper right.  With 11 points, the composition of the binary system shown in the 
example is varied from pure component 1 to pure component 2 with increments of 0.1 in mass fraction.  

Clicking the OK button initiates the calculations. While the calculations are in progress, a small window 
appears indicating the status. To stop the calculations, click the Cancel button. When the calculations are 
complete, a table displaying the results appears. 

 

5.2 Calculating Iso-Property tables 

Selecting the Iso-Property Tables option in the Calculate menu starts calculation of a table with one property 
held constant and either the temperature, pressure, or density varied over a specified range. The following 
dialog allows the selection of the constant and varying properties. Click on one property from each list.  
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Clicking the OK button brings up a dialog for specifying the value of the property held constant and the range 
and increment of the varying property; this dialog is similar to that used to calculate saturation tables (see 
previous section). Default values are provided. The first time a table is calculated for a specific fluid, the 
defaults are based on the current units settings and the properties of the fluid or mixture. For subsequent 
calculations, the default range and increment are those from the previous table. The range and increment 
revert to the default values when a new fluid or mixture is specified. Deselecting the "Reset bounds..." option 
under Preferences retains the range and increment; see Section 7.5. The Leave active check box at the 
lower left keeps the dialog as the top window on the screen, allowing rapid calculation of a series of tables of 
the same type. Multiple tables generated from this procedure can be plotted together by selecting all the 
generated tables (hold down the shift key) in the New Plot menu (Section 6.1).  Alternatively, the Add to 
current table option will add the calculated values for each new isoproperty to the bottom of the current table. 

Clicking the OK button initiates the calculations. While the calculations are in progress a small window 
appears indicating the status; you can stop the calculations by clicking the Cancel button. When the 
calculations are complete, a table displaying the results appears. A blank line in the table indicates a change 
of phase. 

 

5.3 Calculating Tables at Specified State Points 

The Specified State Points option calculates properties at arbitrary values of the independent variables 
(including composition). Selecting this option from the Calculate menu brings up a blank grid similar to a one-
line spreadsheet. 
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The independent variables can be entered in a number of ways: 

1. Values can simply be typed into the cells of the property table. You can move to any cell by clicking 
the mouse in that cell, or move among cells by pressing the Enter, Tab, or arrow keys. 

2. Values can be pasted into the independent variable cells from another application, such as a 
spreadsheet.  Copy the values to the clipboard using the other application's Copy command.  Then, 
in REFPROP, select the desired cell in the table and then use the Paste command. Additional rows 
will be added automatically as needed. 

3. Values can be automatically entered in a systematic manner by right-clicking on the header at the 
top of any column.  This action brings up the Column options window: 

 

To fill a table with a range of numbers, enter a combination of values into the cells under the "Specify 
values" section.  The value to be placed in the first desired row must be specified in the "First value" 
field.  Beneath this field are additional input boxes in which the last value in the range, the increment 
(or a multiplier), or last row can be specified.  If "Increment" is selected, the value of successive rows 
in the table is determined by adding the value in the increment field to the previous value.  Similarly, 
if "Multiply" is selected, successive values are determined by multiplying the previous value by the 
value indicated in the field.  If "Last value" is selected, the variable is varied in uniform increments 
from the specified initial value to the final value.  In the special case where you wish to fill a certain 
number of rows with a constant, enter the starting row, the ending row, and the constant in the "First 
value" field.  The independent values entered must be in the unit system selected with the Units 
command.  You can also specify that the values are saturated liquid or vapor states.  This simply 
adds an "l" or "v" to the number as it places it in the field, as described below. 

4. Values can be read from an ASCII file stored on disk. A specified state point table must be active 
before issuing this command. From the Edit menu, select the Read Data From File command. A 
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standard Open file dialog appears in which you may specify the file containing the independent 
property values. Select the file and the following dialog appears. 

 

The window displays the first 20 lines of the selected file in the box at the top of the window so that you can 
see the format of the values in the file. Although only 20 lines are shown, all of the lines are read in when you 
press the OK button.  Lines in the file that begin with a nonnumeric character, such as *, are treated as 
comments and are ignored.  REFPROP will read one or more values from each line in the file and place 
them in corresponding cells in the blank Specified State Points table. 

In the example shown here, temperature and pressure were chosen as the independent properties and are 
read from columns 1 and 2 of the file. It is not necessary to read all of the properties from the file; for 
example, you can read just the temperature by changing the second box to nothing. 

Extra data from the file can be read and placed in a comment column in the Specified State Points table.  
The capability to read additional data from a file is useful in comparing experimental and calculated values of 
a property, for example.  Before this can be done, the "Add a comment column to tables" option must be 
specified in the Preferences dialog (section 7.5), and a new table containing the comment field must be 
created.  The comment field can then be specified in one of the boxes under the "Insert data into field" label.  
They can then be plotted along with calculated values. 

Whether the independent properties are read from a file or entered manually, as soon as any two valid input 
properties have been entered, the remaining properties will be calculated and displayed in the appropriate 
columns. The inputs can vary from row to row (for example, temperature and density for one row and 
temperature and enthalpy for the next), but not all combinations are supported. Note that you can then 
change the inputs or select new inputs (which causes the calculated values in that row to be erased) and 
repeat the calculation process. 

For mixtures, the composition of the mixture can be entered on a line, but this must be done BEFORE the 
independent variables are entered. Otherwise, the current mixture composition is used. For convenience, the 
"Specified State Points (varying composition)" command can be chosen. This command places the 
composition fields at the beginning of the table (and activates them if they were not selected among the 
properties to be displayed, see Section 7.3).  The composition fields can be moved permanently in the 
Property Order menu. 

Saturation or melting states can be calculated by adding the letters "l", "v", or "m" before or after the value of 
temperature, pressure, density, enthalpy, or entropy.  Note that "m" returns liquid properties at the solid-liquid 
boundary.  REFPROP does NOT calculate solid properties.  In the case where "l" or "v" is entered, and there 
is only one valid liquid or vapor state point, that point is returned regardless of whether or not it is in the liquid 
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or vapor state.  If a liquid density is entered with a "v", the liquid state is calculated internally; however, the 
vapor state is returned.  The same is true for a vapor state entered with "l".  The properties at the critical 
point can be calculated easily by entering "cr", and the properties at the triple point can be calculated by 
entering "tr" (liquid properties can be obtained with "trl" and vapor properties with "trv"). 

For state points that are double valued, the character "<" or ">" can be added to the number (before or after) 
to find the lower or upper root, respectively.  These same characters can also be used to find metastable 
fluid states for temperature and pressure inputs.  For example, the saturation pressure for nitrogen at 100 K 
is 0.778 MPa.  Inputs of 100 K and 0.777 MPa will return a vapor state, but inputs of "100" for temperature 
and "0.777>" for pressure will return a metastable liquid state. 

Saturation properties at specified points may also be calculated using the Saturation Points options as 
described below. 

5.4 Calculating Saturation Properties at Specified Points 

There are two options to calculate saturation properties at specified points in a manner similar to the 
Specified State Point options described in the previous section. They differ in the calculation basis used. For 
the "Saturation Points (at equilibrium)" option, the temperature and pressure of the two phases are the same, 
and the liquid and vapor compositions are in equilibrium, but the compositions are different (except for the 
special case of an azeotrope).  For the "Saturation Points (bubble and dew points at same composition)" 
option, the liquid and vapor are of the same composition, in which case the temperature or pressure of the 
liquid and vapor phases are not in equilibrium. This option is useful when working with a mixture of fixed 
composition. See also the discussion in Section 5.1. 

Either of the Saturation Points options calculates properties at arbitrary values of an independent variable 
(plus optional composition). Selecting this option from the Calculate menu brings up a blank grid similar to a 
one-line spreadsheet. 

 

The independent variable(s) can be entered in the same way as for the Specified State Points tables; see 
Section 5.3. The primary differences are that the Saturation Points tables will have a liquid and a vapor 
column for each property, and only one independent variable is needed to specify the state. Enter a value for 
the liquid phase temperature, pressure, or density to specify conditions at the bubble point, or enter a value 
for the vapor phase temperature, pressure, or density to specify conditions at the dew point. For mixtures, 
the currently defined composition is used for the calculations unless a different value is specified before the 
temperature, pressure, or density is entered. 

When entering temperatures or pressures for mixtures, it is important that the value is placed in the 
appropriate column.  Placing the temperature in the "Liquid phase temperature" column will calculate a 
bubble point with its corresponding vapor state at some equilibrium condition.  Entering the temperature in 
the "Vapor phase temperature" column will calculate a dew point with its equilibrium liquid condition.  These 
two lines will be completely different, and can be confusing if the compositions are not displayed. 
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5.5 Reformatting Existing Data Tables 

The property values are displayed in the calculated tables in a default format, which should be acceptable for 
most uses. The format of a column can be changed, or its position in the table shifted, by clicking on the 
column heading. This brings up the following dialog. 

 

In addition to the default format, three other formats are accessible by clicking on the Style drop-down arrow. 
The "Fixed decimal" style displays values with a fixed number of digits after the decimal place. The "Fixed 
digits" style displays values with a fixed number of significant digits. The "Scientific notation" style displays 
values in scientific notation with a fixed number of digits in the ordinate. You can select the desired number 
of digits by typing the value in the edit box, or using the small up or down arrows to increase or decrease the 
displayed value. An example of the selected format is shown above the style drop-down box. 

The user is cautioned that, by the very nature of a calculational database, property data are often displayed 
with more digits than can be justified based on the accuracy of the property models or the uncertainties in the 
experimental data to which the models were fitted. A large number of digits may be useful for the smooth 
plotting of results, the evaluation of numerical derivatives, or checking results with the original source.  

The position of a column in the table can be changed by editing the value in the edit box in the middle of the 
dialog. The number of digits can be changed for all columns and all tables in the Preferences dialog under 
the Options menu (see Section 7.5). 

The width of the data columns can be changed by placing the mouse over the line separating the header of 
two columns. When the cursor changes to a double-headed arrow, click and drag the line to a new position. 
The column widths are also enlarged in some operations when the width of the numbers in the column 
exceeds the column width. 

5.6 Warnings and Errors 

It is not always possible to complete the requested property calculations. In such instances, the program 
returns a notation such as "not applicable" in a table cell, a warning message, or an error message.  

Certain properties are not defined at states that are otherwise valid. For example, the viscosity and speed of 
sound are not defined for a two-phase state. The surface tension is not defined for single-phase states. In 
such cases the term "not defined" is displayed in the corresponding table cell(s), and the remaining 
properties are displayed normally. The quality can be defined in a variety of ways for subcooled liquid and 
superheated vapor states, and it is not defined for supercritical states. In these cases, the state (subcooled, 
superheated, or supercritical) is displayed in the table cell(s) for quality. 
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Warnings indicate a situation in which the calculated values may be suspect. The user is informed that one 
or more requested states has resulted in a warning by an Alert box, which is displayed after all calculations 
have been completed. The entire row in the table resulting in a warning is displayed in an italic font (even 
though the warning may arise from the calculation of a single property). You can view the warning message 
by clicking the affected row number(s). 

 

Warnings are most commonly encountered when transport property values are requested at a temperature 
and/or pressure outside of the range of the model used for the calculations. (The transport property models 
often have a more limited range than the corresponding thermodynamic property model; in these cases, the 
thermodynamic properties are calculated normally, but the transport properties generate a warning.) 
Warnings are also issued when the temperature and/or pressure are above the stated limits of the equation 
of state. 

An error indicates a situation in which calculations are not possible. This may be because of the failure of an 
iteration loop within the property routines to converge on a solution, but more commonly, is because states 
were requested for which calculations are impossible. For example, saturation calculations are not possible 
above the critical temperature for a pure fluid. In addition, while an equation of state can usually be 
extrapolated to slightly higher temperatures or pressures than the stated limits with good results, 
extrapolation to lower temperatures or higher densities can give nonsensical results and is not allowed.  

When an error is generated by the property routines, an Alert box is immediately displayed giving the error 
message and the option to continue or cancel further calculations in the table. If the Yes button is clicked, 
calculations continue (although further errors are likely). The "Yes to All" button suppresses further error 
messages of the same type. If the No button is clicked, any rows calculated before the error was 
encountered are displayed, but no further calculations are attempted. 

 



 

 REFPROP 23

6. CREATING AND MODIFYING PLOTS 
(The Plot Menu) 

The REFPROP program provides plotting capability for any data appearing in a table. In addition, simple 
plots of the thermodynamic surface can be easily generated over a wide range of coordinates, including 
temperature-entropy and pressure-enthalpy diagrams. Temperature-composition and pressure-composition 
diagrams for binary mixtures can be generated automatically. While these plotting capabilities help in the 
visualization of data trends and are adequate for many other purposes, the program is not intended to 
compete with programs devoted to plotting and data analysis. If you need to produce publication-quality plots 
or to carry out statistical analyses or other data manipulations, we recommend that you transfer the property 
data from REFPROP to such a program. Section 9 of this manual describes the process for transferring  data 
to other programs. 

6.1 Plotting Data from Tables 

Once one or more property tables have been calculated, x-y plots can be generated by the New Plot 
command. The dialog shown below is divided into three blocks, which control the x-axis, the y-axis, and the 
source and appearance of the plotted data. 

 

By default, it is assumed that data from the topmost table window are to be plotted. Other tables can be 
selected using the list at the upper right of the dialog. It is also assumed that all rows in the selected table are 
to be plotted. If this is not desired the starting and ending row numbers can be entered in the edit boxes 
below the table list.  Data from multiple tables can be plotted simultaneously by selecting multiple items in 
the "Plot data from" list and pressing "OK".  You must be careful that the selected items all contain the same 
columns. Plotting data from isoproperty tables and saturation tables together must be done in two steps 
(once with New Plot, then with Overlay Plot, see next section). 

The variables to be plotted on the x- and y-axes are selected by clicking the properties listed in the scroll 
boxes at the left and middle of the dialog.  

Minimum and maximum values for the plot frame are generated as the x- and y-variables are selected. The 
"Interval" value represents the spacing of axis tic marks. These values can be changed by typing new values; 
they can also be changed later using the Modify Plot command, which is described below. The format of the 
axis labels is controlled by two small drop-down boxes. The first provides access to a fixed decimal format, 
"F", or exponential notation, "E". The second "Format" drop-down box controls the total number of digits 
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(before and after the decimal point) with either format. Either a linear or logarithmic axis scaling can be 
specified by the radio buttons at the bottom of the dialog. Finally, a check box turns grid lines on or off. 

The appearance of the plotted points is controlled by the options in the lower right portion of the dialog. 
Points can be connected by a variety of line widths, or no line at all, by selecting the desired option in the 
drop-down list labeled "Line." The "Symbol" drop-down list provides access to a variety of plotting symbols, 
including no symbol. (The choice of "none" for both the line type and symbol is allowed, but this results in a 
rather uninteresting plot.) The color of both the line and symbol is also controlled by a drop-down list. The 
default values for these attributes can be saved by clicking the Save As Default button. 

6.2 Overlaying Data onto Existing Plots 

You can plot additional data onto existing plots by using the Overlay Plot command. The command acts on 
the topmost plot window; if a different plot is desired, select it before executing the Overlay Plot command. 
This command brings up a dialog virtually identical to that for New Plot, and works in the same way. Overlaid 
plots use the existing scales for the ordinate and abscissa.  However, if the overlaid plot has values that 
cause part or all of the plot to be off scale, a dialog is presented that asks if you want to rescale the plot. It is 
the user’s responsibility to ensure that plots are not overlaid in meaningless combinations. In particular, the 
quantities in the individual data sets plotted should have the same units. 

6.3 Predefined Diagrams 

A number of common diagrams are predefined in the program and can be automatically generated for the 
currently defined fluid or mixture. Once plotted, these predefined plots can be modified, or additional data 
can be overlaid on them, in the same fashion as for any other plot. 

6.3.1 Diagrams of thermodynamic surfaces 

Skeleton diagrams of the thermodynamic surface of the current fluid or mixture can be generated. The types 
of diagrams that can be plotted include: 

Temperature vs. Entropy 
Temperature vs. Enthalpy 
Temperature vs. Density 
Pressure vs. Enthalpy 
Pressure vs. Density 
Pressure vs. Volume 
Pressure vs. Temperature 
Compressibility Factor vs. Pressure 
Enthalpy vs. Entropy 
Isochoric Heat Capacity vs. Temperature 
Isobaric Heat Capacity vs. Temperature 
Speed of Sound vs. Temperature 
Exergy vs. Enthalpy 
Isothermal Compressibility vs. Temperature 
Viscosity vs. Temperature 
Thermal Conductivity vs. Temperature 
Temperature vs. Composition (for binary mixtures only) 
Pressure vs. Composition (for binary mixtures only) 

Selecting any of these options brings up a dialog in which the properties to be plotted can be specified as 
shown below.   
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Each diagram type will allow different combinations. In the example shown, a pressure vs. enthalpy diagram 
can display lines of constant temperature, density, entropy, and/or quality. To plot a property, place a check 
in the box to the left of the label.  You can then specify a range of values to be plotted or up to 12 individual 
values (by pressing the "More" button), or both.  

The minimum and maximum values of the x and y axis can be modified. These values can also be changed 
later with the Modify Plot command; however, some data may not be calculated beyond the ranges indicated 
in these boxes, and a new diagram will have to be generated with larger bounds. 

For cases where multipliers are preferred rather than increments in the "From...To...Step" inputs, the 
character "*" can be added in front of the step input.  Thus, inputs of "From:  0.001, To:  1000, Step:  *10" 
would produce isolines of 0.001, 0.01, 0.1, 1, 10, 100, and 1000.  The More/Less button can be selected to 
include/exclude additional boxes where property values can be individually added. 

Labels identifying the isoproperties are automatically generated if the "Include labels" option is selected.  You 
can change or delete these text items or add additional text using the Add Label command.  If too many 
labels are being placed on a plot, the "Unlabeled lines" option can be used to specify that labels should occur 
on every other line, every third line, and so on.  The appearance of the plot can be modified with the Modify 
Plot command and with the controls in the Plot window. 

The amount of data calculated, resulting in fine or coarse plots, can be selected in the "Point spacing" option.  
Several additional options are available to control whether the saturation lines are drawn, the melting line is 
drawn, and the saturated liquid and vapor states are connected by lines.  The "Swap density for specific 
volume" option will change the density inputs to volume inputs.  The "Add s and v lines at saturated 
temperature" option will draw a vapor phase isochore and a vapor phase isentrope for each isotherm that is 
plotted, using the value of volume and entropy at the saturated vapor state point. 

In addition, values in the two-phase region can also be plotted with the "Show 2-phase" check box (if the 
"Show options used for analyzing equations of state" preference is turned on in the Preferences).  By default, 
this option is not selected, and a straight line is drawn between the saturated liquid state and the saturated 
vapor state. For mixtures, showing two-phase values will be very computationally intensive. When plotting 
isotherms for a pure fluid, the two-phase option works differently than might be expected:  values of the 
metastable states are shown, both real, and inaccessible.  However, you should realize that there are 
virtually no data for metastable states of most fluids, and values shown will be extrapolations of the 
equations of state. Indeed, a major use of this option is to examine the behavior of equations of state. In 
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addition, calculated values can be extremely large, and plotting these values can result in unexpected plots 
of the two phase region. 

Other properties can be plotted as well using these same techniques.  Under the "Axis" scaling label in the 
plot dialog, the x and y properties can be changed by selecting the down arrows and clicking on the desired 
property.  Most of the properties available in the Properties dialog can be plotted on the y axis.  Properties 
allowed on the x axis include temperature, pressure, density, volume, energy, enthalpy, entropy, 
compressibility factor, exergy, –1/T, and composition.  In order to avoid problems where one of the four 
columns at the top of the plot dialog matches one the properties on the x or y axis, you should carefully 
select as a starting point one of the diagrams in the Plot pull down menu that contains your x or y property.  
For example, to generate a plot showing the Prandtl number vs. temperature, you could start with a T-s 
diagram so that the upper four columns show pressure, density, enthalpy, and quality.  If a T-h plot was 
selected, then the third column would contain entropy instead of enthalpy.  Once this is done, the y axis 
property should be changed to the Prandtl number.  Once the initial plot is setup, you can then go to the 
Plot/Other Diagrams option to modify your previous settings. 

6.3.2 Phase diagrams 

A phase diagram plotting bubble (saturated liquid) and dew (saturated vapor) lines as functions of 
temperature and composition for constant values of pressure is generated by the T-x Diagram command. 
The P-x Diagram command generates a similar diagram on pressure-composition coordinates for constant 
values of temperature. These options are available only for binary mixtures; the commands are disabled for 
pure fluids and for mixtures with three or more components. The picture below displays the output of a T-x 
plot for R508A.  [Note that while R508A is defined as the blend of R23 and R116 at a composition of 
(39.0/61.0), the T-x diagram covers the entire composition range from (0.0, 100.0) to (100.0, 0.0).] 

 

6.4 Modifying Plots 

6.4.1 The Modify Plot command 

Many of the attributes of a plot can be changed through the Modify Plot command. This command can be 
accessed by the pull-down menu item or by double-clicking anywhere within an existing plot. In the former 
case, the plot in the topmost window is affected. If the topmost window is not a plot, the most recent plot is 
acted on. 

The dialog for this command is similar to that used to specify a new plot, except that the variables plotted 
cannot be changed (although the x- and y-axis labels can be edited). As with the New Plot command, linear 
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or logarithmic scaling can be selected, and the plot limits and axis label formats can be changed. Options to 
modify the size of the axis labels are provided below the "X-Axis" and "Y-Axis" portions of the dialog. 

 

A list box in the upper right lists the individual data sets plotted. Selecting an item allows editing of the line 
and symbol attributes for that data set. The Remove button permanently deletes the selected data set. (Note 
that for the predefined plots, there is an entry for each of the lines composing these diagrams.) Select the 
data set for which the line type, symbol, and/or color specifications are to be applied. These changes can be 
made to one data set at a time or to a multiple selection (by shift-clicking). After changes have been made, 
either the Apply button or the OK button can be selected.  By pressing the Apply button, other changes can 
be made as well. 

6.4.2 Adding and deleting labels 

The Add Label command places text in a plot window. A plot must be in the foremost window for this 
command to be active. Invoking this command brings up a dialog in which you can type the desired text. 
Other text characteristics including the font, size, and color can also be edited. The "Opaque background" 
option is invoked by a check box; when this option is turned on, any lines "underneath" a text label are 
blocked out. 

 

You can modify an existing label (including those generated through the predefined plots) by double-clicking 
within the boundaries of the text. A label can be permanently deleted with the Delete button. The Delete All 
button deletes all the labels on a plot. 

Labels can be moved by clicking within the text boundaries and dragging the text to its new location. 
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The degree character can be entered into the text of the label by pressing Alt-248 (or Alt-0176) on the 
numeric keypad.  Alt-253 will add a superscript "2" to the text.  In addition, Alt-0178 will add a superscript "2" 
and Alt-0179 will add a superscript "3".  Other special characters of interest using the Alt key include 225: ß, 
230 (or 0181): μ, 241 (or 0177): ±, and 246: ÷.  

6.4.3 Resizing and moving plots 

The size of the plot frame can be changed. Place the cursor over the lower right corner of the plot window; 
the cursor changes to a double-ended arrow to indicate that you are in the resize mode. Click and hold the 
mouse button while dragging the corner of the plot to enlarge or reduce the plot size. 

6.4.4 Reading coordinates off a plot 

You can display the (x, y) coordinates of any location within the plot frame. Press the Shift key to display 
cross hairs within the plot frame and numerical coordinates (in units corresponding to the plot axes) appear 
in the title bar of the plot window. Use the mouse to move the cross hairs to any desired point in the plot.  

6.4.5 Zooming 

The area displayed in a plot can be changed. Click and drag the left mouse button to create a box.  When 
the mouse button is released, the area within the box will become the new plotted area. The plot area can 
also be zoomed in or out by a factor of two with the Zoom In and Zoom Out options in the Plot menu. The 
Zoom Full Frame option returns the plot to its original bounds set by New Plot or Modify Plot. 

6.4.6 Add a point to a table 

When the right mouse button is clicked within the plotting area, the spot will be marked with a circle, and the 
values of the properties at the selected state point will appear on the most recently used table (created from 
Calculate/Specified State Points).  If no table is active, the right mouse button marks the spot with a circle 
only.  Points added to the plot in this fashion can then be connected with lines or deleted by entering the 
Modify Plot option. 
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7. CHANGING OPTIONS AND PREFERENCES 
(The Options Menu) 

Under the Options menu, you can choose the units of measure for the calculations, the reference state for 
enthalpy and entropy, the properties to be displayed, and other options. All of these options can be saved 
(together with the currently defined fluid or mixture) for use in a future session. Any changes in these options 
apply to all subsequent tables but do not affect any existing tables (with one exception, as explained below). 

7.1 Units 

The Units command brings up a dialog in which the units of the various properties can be specified. The 
current settings are displayed down the left side of the dialog window. Some properties use combinations of 
the displayed settings and cannot be specified independently. For example, if kilograms and kilojoules are 
specified for mass and energy, respectively, enthalpy is displayed in units of kJ/kg. 

 

Multiple buttons are available for selecting default sets of unit; for example, standard SI or English units.  
Other sets include standard SI units with Celsius for temperature, a mixed set of SI and English units, and an 
option to use unitless dimensions for some variables, including temperature divided by the critical 
temperature, pressure divided by the critical pressure, and so on.  Units can also be set individually—click on 
the arrow to the right of the current unit setting. A drop-down list of available choices appears. Click the 
desired unit.  

Specific properties (i.e., those expressed in terms of a unit quantity) are reported on either a mass or molar 
basis (e.g., kJ/kg or J/mol). Select the desired basis by the radio buttons under the heading "Properties." The 
molar and mass bases govern the selection in the Mass list box. For example, selecting "kg; kmol" specifies 
kilograms if the mass basis is selected and kilomole (often called a kilogram mole) for the molar basis; 
selecting the English units "lb; lb mol" specifies pounds and pound moles.  

The basis for the compositions is specified independently of the mass or molar basis for the specific 
properties. This allows you, for example, to specify a mixture composition on a mole fraction basis and 
display the properties on a mass basis. 

Pressures can be expressed as gage pressures by selecting the "Use Gage Pressure" option.  The 
atmospheric pressure or elevation at the location of interest is required to use this option. 



 

 REFPROP 30 

7.2 Enthalpy and Entropy Reference States and Exergy 

When large differences in enthalpy and entropy occur between REFPROP and tables of properties given in 
handbooks, please note: 

The absolute values of enthalpy, entropy, and energy at a single state point are meaningless. It is 
only the difference between two different state points that matter. Thus, the value for a single state 
point can be set to any arbitrary value. Many handbooks set the arbitrary state point so that the 
values of these properties are positive for most liquid or gas states. You can change the values of 
the arbitrary state points by going to the Options/Reference State menu.  Your choice of options can 
be permanently saved in the graphical interface by selecting Options/Save Options, and then saving 
the options under the file name "defaults.prf". 

The properties of enthalpy and entropy are computed as differences relative to some arbitrary reference 
state. The Reference State command allows the selection of one of three conventions (or a user-defined 
state): 

1. The "normal boiling point" (NBP) choice sets the enthalpy and entropy to zero for the saturated liquid 
at the normal boiling point temperature.  

2.  The choice of zero for enthalpy and entropy for the saturated liquid at –40 °C (= –40 °F) corresponds 
to the reference state traditionally used for refrigerants in the United States, including the tabulations 
of the American Society of Heating, Refrigerating and Air-Conditioning Engineers (ASHRAE). 

3.  The International Institute of Refrigeration (IIR) has adopted reference state values of 200 kJ/kg and 
1 kJ/(kg-K) for enthalpy and entropy, respectively, for the saturated liquid at 0°C. ASHRAE also uses 
this reference state for most refrigerants in its tables in SI units. 

 

A user-specified reference state can also be selected. If that radio button is selected, the four edit boxes 
underneath it become active. Enter the desired values of enthalpy (h) and entropy (s) at the reference state 
temperature (T) and pressure (P) into the edit boxes. 

Some of the above reference states may not be applicable to a given fluid. For example, the IIR and 
ASHRAE reference states specify a reference temperature above the critical temperature for methane. A 
reference state that does work is stored in the data file for each fluid. This reference state will be read from 
the file and applied if the choice "Use the default reference state" is selected.  
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For mixtures, any of the above reference states can be applied to each of the pure components individually 
or to the currently defined mixture by selecting the appropriate radio button at the bottom right of the dialog. If 
the pure component option is selected, the enthalpy and entropy of a mixture differ from the selected 
convention by amounts equal to the enthalpy and entropy of mixing. The option of specifying the reference 
state for the currently defined mixture is convenient when working with a refrigerant blend of specified 
composition. 

The reference state dialog also specifies the conventions used for exergy. Exergy is a specialized property 
that is used in reversibility analyses of thermodynamic cycles. Exergy values are referenced to a "zero" state, 
which is often taken to be ambient conditions. The reference or zero-state temperature is specified by 
entering a value in the "To =" edit box. This zero-point temperature may then be associated with a zero-point 
pressure or the saturation state of the fluid by selecting among the radio buttons.  

7.3 Properties Calculated 

The properties to be displayed in calculated tables are controlled by the Properties dialog. The properties are 
organized into categories that are accessed by the tabs at the top of the dialog. Click on the desired category 
tab and select or deselect any property by clicking the check box next to its name. All of the properties for the 
displayed category may be selected or deselected by the "Select All" or "Clear All" buttons at the lower right. 
Results from the Thermodynamic tab are shown below: 

 

 

In the lower part of the dialog, a pair of radio buttons controls whether properties for the liquid and vapor 
phases are to be displayed in addition to bulk properties. Liquid-phase properties are denoted by "Liquid" or 
"Liquid phase" in the table heading; "Vapor" or "Vapor phase" denotes the vapor-phase properties. The bulk 
properties have neither designation. For single-phase states, the bulk properties are the same as either the 
liquid- or vapor-phase properties.  For two-phase states, the properties of the overall or bulk state are a 
combination of the saturated liquid and saturated vapor properties. Note that some properties, including 
speed of sound and viscosity, are not defined for two-phase states. (For saturation tables, this choice affects 
only tables with quality as the independent variable. For other types of saturation tables, the saturated liquid 
and saturated vapor properties are always displayed.) 

Most thermodynamic and transport properties can be calculated.  The properties that can be displayed are 
divided into five categories:  thermodynamic properties, transport properties (plus surface tension and 
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dielectric constant), derivatives of the thermodynamic properties including isothermal compressibility and 
volume expansivity, special properties, and properties of special interest to mixtures. Examples of the 
properties available for the various tabs (other than the Thermodynamic tab) are shown below: 

 

 



 

 REFPROP 33

 

 

 

Thermodynamic properties include temperature (T), pressure (p), density (D), volume (V), internal energy (e), 
enthalpy (h), entropy (s), isochoric (Cv), isobaric (Cp), and saturation (Csat) heat capacities, ideal gas 
isobaric heat capacity (Cp0), ratio of Cp to Cv, speed of sound (w), compressibility factor (Z=p/DRT), Joule-
Thomson coefficient (JT=dT/dp at constant h), quality (q=ratio of vapor moles to total moles), 2nd virial 
coefficient (B), 3rd virial coefficient (C), Helmholtz (a) and Gibbs (g) energies, and the heat of vaporization 
(hvap).  Most of these properties are given on a molar or mass basis, e.g., V=volume/number of moles, or 
volume/mass.   

The transport properties include the thermal conductivity (ThC), viscosity (Vis), kinematic viscosity (Vis/D), 
thermal diffusivity (ThC/D/Cp), and Prandtl number (Vis*Cp/ThC).  The surface tension and dielectric 
constant are included under the transport properties menu, as are the Gross Heating Value and the Net 
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Heating Value. The gross heating value is the amount of heat produced by the complete combustion of a unit 
quantity of fuel, with any water generated in the combustion assumed to condense to liquid, while the net 
heating value is obtained by subtracting the latent heat of vaporization of water vapor from the gross heating 
value, i.e., the water produced remains in the vapor phase. 

Derivative thermodynamic properties include the isothermal compressibility [kappa=1/kt/p= –(dV/dp)/V at 
constant T], volumetric expansivity (also known as the thermal expansion coefficient) [beta=(dV/dT)/V at 
constant p], isentropic expansion coefficient [k=w2*D/p=–V/p(dp/dV) at constant s], isothermal expansion 
coefficient [kt=D/p(dp/dD) at constant T], adiabatic compressibility [betas=1/k/p=–(dV/dp)/V at constant s], 
adiabatic bulk modulus [Bs=k*p=–V(dp/dV) at constant s], isothermal bulk modulus [Kt=kt*p=–V(dp/dV) at 
constant T], isothermal throttling coefficient (–JT*Cp = dh/dp at constant T), and Gruneisen value (dpdT*V/Cv 
at constant V).  Additionally, properties contained under the derivative tab include most of the common 
derivatives of density, pressure, temperature, and enthalpy with each other.  The property dp/dT [sat] is the 
derivative of the vapor pressure with respect to temperature.  The property dh/dZ [sat] is the Waring function 
(as given in Ind. Eng. Chem., 46:762, 1954) and dB/dT is the derivative of the second virial coefficient with 
respect to temperature (B is only a function of T). 

Special properties include the acoustic virial coefficients, the negative reciprocal temperature (–1/T), (Z–1) 
over the density, exergy on a flow basis (H–T0S), exergy for a closed system (H–P0V–T0S), specific heat 
input [V(dh/dV) at constant p], Cv in the two-phase region (Cv2phase) (only calculated for pure fluids), 
supercompressibility factor (Fpv=square root of the compressibility factor at 60 °F and 14.73 psia divided by 
the square root of the compressibility factor at T and p), critical flow factor (the normalized sonic mass flux for 
inviscid, one-dimensional, steady, isentropic flow), and the internal pressure [T(dp/dT)–p at constant D].  The 
(Z–1)/D values are best viewed in the Diagrams menu and are interesting in that the values at zero density 
are the second virial coefficients and the slope of the isotherms at zero density are the third virial coefficients.  
The ideal gas values of density, enthalpy, entropy, Gibbs energy, and Helmholtz energy are also available 
(note that these are the ideal values at T and p, not the ideal values at zero pressure such as is the case with 
Cp0). 

Within the "Special" properties tab is the ability to calculate values for metastable fluid states (such as a 
liquid that has been superheated beyond the saturated state).  These include pressure, enthalpy, entropy, 
Helmholtz energy, Gibbs energy, and compressibility factor.  For single phase states, the values of these 
properties will be identical to those calculated under the "Thermodynamic" properties tab.  However, in the 
two-phase region, the values given are the metastable fluid states, or more precisely, the properties 
calculated from the equation of state at the given temperature and density.  The easiest way to generate 
these values is to calculate an isotherm in the Isoproperty Table command, varying the density.  The two-
phase pressure for a pure fluid, calculated from the equation of state, can also be viewed by plotting a p-D 
diagram with the "Show 2 phase" option checked. 

Finally, the “Mixture” tab provides additional properties, that are of particular interest to mixtures such as 
excess properties (volume, energy, enthalpy, entropy, Helmholtz and Gibbs energies), the K value 
(vaporization equilibrium ratio–the ratio of the vapor mole fraction of a species to the liquid mole fraction of a 
species), fugacity(f),  fugacity coefficient (fi/xip), and chemical potential. The composition (on either a mass 
basis or mole basis) and molar mass (molecular weight) are also found on this tab. 

 

7.4 Property Order 

The property order dialog, shown below, establishes the order in which the properties are displayed in a 
table. 
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Select the property that you wish to move, and use the "Move up", "Move down", "Move to top," or "Move to 
bottom" buttons to change the position of that property in any subsequent tables.  The property order can 
also be changed by selecting a property with the up and down arrow keys or the mouse, and then moving 
the property using the up and down arrow keys while holding down the shift key. 

7.5 Preferences 

The Preferences item in the Options menu brings up a dialog in which you can specify the behavior of the 
program in a number of aspects. Clicking on the check box next to the item activates or deactivates that 
option. 

If the "Prompt to save session when closing" option is selected, you will be prompted when the program is 
terminated to save the session to a file before closing.  This file can then be retrieved by selecting the Open 
Session command (Section 8.2) when the program is run again. 

The "Prompt before deleting row" option prompts you before a row is deleted in a table (by either pressing 
Shift-del or selecting the Delete Row option while editing a table). Note that a row cannot be recovered after 
it has been deleted.   

The "Ignore all error messages" option will cause all error messages that occur during property calculations 
to be ignored.  While this option may relieve you of having to clear such error messages, it may cause 
confusion when properties are not returned after entering inputs out of range or when the program does not 
converge. 

The "Copy table headers to clipboard with table data" option can be used to select whether or not the 
headers at the top of each table are included when copying data to the clipboard (Section 9.1). (Table 
headers from REFPROP tables are automatically suppressed when you paste data into a Selected State 
Points table.) 

When the "Show saturation boundaries in tables" option is selected, a blank line will appear between the 
single and two-phase state points and the boundary between the liquid and vapor phases in subsequent 
tables. 

The steam conversion option will use the conversion 1 cal = 4.184 J when not selected, and the conversion 1 
cal = 4.1868 J when selected.  The latter value is generally used with the calculation of water and steam 
properties. The former value (4.184) should be used with all other fluids and mixtures. 

In certain applications, such as using Asian settings with Microsoft Windows, the degree sign, the superscript 
2, and the superscript 3 may not be properly displayed, causing unit conversions to not work and displaying 
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units with odd symbols.  In such cases, the nonstandard characters should be turned off, resulting in the loss 
of the degree signs. The text "^2" and "^3" will be used in place of the superscript 2 and 3. 

The default bounds used for the independent variables in calculating tables normally changes when the fluid 
or unit system is changed. By deselecting the "Reset bounds..." option, the previous bounds are retained. 
This is useful if you want to compare properties for several fluids over similar ranges of conditions. 

 

The "Flip usage of commas and periods in numbers" option allows REFPROP to conform to either the 
European or American convention for the decimal point. REFPROP will, however, usually recognize a user's 
system settings, and this option will not be required. 

The "Add Notes button to graphs" option will add a small command button in the upper left corner of each 
plot that allows the user to add notes to a particular graph.  These notes will be printed out under the plot 
when File/Print is selected.  If this option is deselected, the notes that correspond to each plot will not be lost, 
but will not be accessible. 

The option to add a comment column to tables will add one or more extra columns (up to 10) in each table.  
The extra column(s) can be used to enter comments or user data.  The values in this field will be ignored in 
calculations, but numerical values can be plotted in the same manner as calculated properties.  Adding text 
in each field can aid you in labeling each state point, and the size of the comment field can be enlarged by 
clicking and dragging the mouse. The comment columns are put at the end of the table by default, but this 
can be changed under Property Order as described in Section 7.4. 
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The 'Show options used for analyzing Equations of State' will add the rectilinear diameter to all plots, 
additional plot items, and the 'Show 2-phase' option for plotting metastable states for pure fluids. 

The mixture models used in REFPROP vary by type of mixture (e.g., refrigerant mixtures use different 
models than hydrocarbon mixtures).  The mixture model can be specified by selecting the appropriate radio 
button in the Preferences menu.  Constituents typically found in natural gas are modeled by the latest GERG 
model (completed in 2004 and extended in 2008).   The mixing part of the model (the excess contribution) is 
similar to that used for the refrigerant mixtures.  The pure fluid equations of state have been shortened and 
differ from the default equations in REFPROP.  The calculations using these shorter equations are 
somewhat faster than the default equations, but are slightly less accurate.  If the user wishes to use the 
shorter equations specified by the GERG-2008 model, the 'Use full GERG-2008 natural gas mixture model' 
option should be selected.  This will result in slightly different values than the default values.  In either 
situation, the mixing interaction parameters remain the same.  The documentation for this model was 
published as: 

Kunz, O., Klimeck, R., Wagner, W., Jaeschke, M. The GERG-2004 Wide-Range Equation of State for 
Natural Gases and Other Mixtures. GERG Technical Monograph 15, Fortschr.-Ber. VDI, VDI-Verlag, 
Düsseldorf, 2007. 

Calculations from the older American Gas Association program for natural gas mixtures can also be made by 
selecting the 'Calculate mixture properties using the AGA8 equation'.  This equation is not valid in the liquid 
phase or in the extended region near the critical point and users of this model should be aware of the 
uncertainties in the equation in the various regions where they calculate numbers.  The default equations in 
REFPROP are used to calculate the phase boundaries since the AGA8 model does not allow this 
calculation. 

The 'Use Peng-Robinson equation for all calculations' option switches from the default equations to the less 
accurate Peng-Robinson equation.  This equation is not recommended for general use in REFPROP, but it 
does result in substantially faster calculations in some cases, especially saturation states. 

For those in the natural gas industry, differences between the default equations being used and properties 
calculated from the AGA-8 equation of state can be plotted versus temperature along isobars.  In order to 
make the options available in the Plot menu, select the "Show menus for graphing deviations between AGA-
8 and GERG" option in the preferences. 

In addition to these options, the number of digits in the tables and the font size used for the tables can be 
selected on a global basis, rather than by individually selecting the number of digits as described in 
Reformatting Existing Data Tables (Section 5.5). Changes in the number of digits displayed will be applied to 
currently displayed tables if the "Apply to existing tables" option is selected. The "Fixed decimal" style 
displays values with a fixed number of digits after the decimal place. The "Fixed digits" style displays values 
with a fixed number of significant digits. The "Scientific notation" style displays values in that format with a 
fixed number of digits in the ordinate. An edit box below the style can be used to select the desired number 
of digits, or the small up or down arrows can be used to increase or decrease the displayed value. 

The preferences are saved when the Save Current Options command is issued (see next section).  They are 
restored to a previously saved option with the Retrieve Options command (see Section 7.7). 

7.6 Saving Current Options and Preferences 

The current settings can be saved at any time. The settings saved include the currently defined fluid or 
mixture, units of measure, the reference state for enthalpy and entropy, the properties to be displayed, and 
the options specified in the Preferences dialog. Selecting the Save Current Options command brings up a file 
save dialog in which you can specify the filename to contain the current settings. Settings files are identified 
with the ".prf" file name extension. You can save multiple settings files corresponding to different projects. 

The program reads the settings file "defaults.prf" at startup. If you want to have the current options used as 
the default settings, save them in the "defaults.prf" file. An Alert box informs you that the file already exists 
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and asks if you want to replace the existing file; click Yes to save the new defaults. To start REFPROP with a 
different preferences file, include the name of that file on the command line used to start REFPROP. 

If the "defaults.prf" file is deleted or missing, the program will revert to internal defaults (which will probably 
not correspond to your preferences). If you inadvertently delete the "defaults.prf" file you can rename another 
settings file to "defaults.prf" and place it in the same directory as the REFPROP executable.  Be careful not 
to confuse any "filename.prf" file with a "filename.rfp" file (a REFPROP session file). 

7.7 Retrieving Previously Defined Options 

Any previously stored settings can be loaded by executing the Retrieve Options command. This brings up a 
File Open dialog. The settings files are identified by a ".prf" filename extension. Select the name of the 
desired settings file and click OK to load those previously defined settings including the fluid or mixture, units 
of measure, the reference state for enthalpy and entropy, the properties to be displayed, and the options 
specified in the Preferences dialog. 
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8. SAVING AND PRINTING 
(The File Menu) 

8.1 Saving and Closing Sessions 

A session in the REFPROP program consists of all table and plot window(s) on the screen together with the 
settings defining the fluid, unit system, reference state, and selected properties used to generate those 
windows. You can save a session at any time. This means that the complete current state of the program is 
saved to disk. The Save command brings up a File dialog. Select the desired directory and enter a filename; 
the ".rfp" file-type extension identifies a file as a REFPROP session file to the program. 

The Close command closes all table and plot windows currently on the screen, but the program itself 
remains running. If you have not already saved the session, a dialog asks if you want to save the current 
session before closing (unless you have disabled this reminder under the Preferences dialog). 

8.2 Retrieving a Previously Saved Session 

A previously saved session can be retrieved by the Open command. This command, combined with the Save 
command, is a very powerful combination that allows you to stop work on a REFPROP analysis and return to 
it later or work simultaneously on several different analyses at one time. 

The Open command brings up a File dialog where you specify the file storing the desired session. Upon 
pressing the OK button, the specified session is restored with all of its constituent tables and plot windows on 
the screen. The settings defining the fluid, unit system, reference state, and selected properties used to 
generate those windows are also restored. Opening a saved session will delete any current windows; in this 
case an alert box will ask if you wish to save the current work first. 

8.3 Saving Tables 

The Save Tables command displays a dialog that allows you to select one or more of the current tables to be 
saved to disk in an ASCII format. The available tables are shown in the list at the left, with the most current 
one shown on the right. Click on the name of the table you want to save and then click on the ">" button to 
add that table to the list of tables to be saved on the right. The ">>" button moves all of the available tables to 
the right list. You can remove a table from the "to be saved" list by highlighting its name and pressing the "<" 
button. Similarly, all of the tables can be removed by pressing the "<<" button.  

 

The check boxes at the lower left provide the option to include the column heading (consisting of the property 
and units on separate lines) and/or the row numbers together with the data. A delimiter selected by the radio 
buttons at the lower right is placed between each value in a row. Most spreadsheet programs use the tab 
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character to place items in separate cells. A carriage return is placed at the end of the row. When saving 
tables, the "Full width" option prints each line of the table on a single line of the file; this can result in very 
long lines.  The "Page width" option formats the tables so that all the properties fit within 80 columns in the 
file.  The lines are broken up and printed in different sections, similar to that done during printing. Multiple 
tables, if specified, are saved to a single file. The tables in the selected list are saved or printed in the order 
in which they appear in the list. 

8.4 Printing 

The Print Setup command brings up the standard Print Setup dialog that provides access to print options, 
such as landscape or portrait format and printer selection. These options are applied to subsequent output 
from the Print command. This command need be used only when the default printer or printer options are to 
be viewed or changed. 

The Print command allows any of the tables or plots to be printed. The available windows are shown in the 
list at the left, with the most current one shown on the right. Click the name of the table or plot you want to 
print and then click the ">" button to add that window to the list on the right. The ">>" button moves all of the 
available windows to the right list. You can remove an item from the "print" list by highlighting its name and 
pressing the "<" button. Similarly all of the tables and plots can be removed by pressing the "<<" button. 
Clicking OK initiates the print process. 

 

The check boxes at the lower left allow you to include the column headings (containing the property names 
and units) and/or the row numbers on the printed output of tables. The "Include header" check box will also 
print out the window header containing the date, time, etc. Multiple tables or plots are printed in the order 
they appear in the "to be printed" list. 

The Print Dialog command allows for a few additional options while printing, most important is the "Print to 
file" option.  This option sends the output to a file that can then be used in such applications as making 
PDFs.  Unlike the Print Setup command, the Print Dialog command first displays the menu for selecting 
tables or plots to print, then activates the dialog menu before printing. 

8.5 Exiting REFPROP 

The Exit command provides a graceful way to exit (quit) from the program. You are prompted to apply Save 
Session if it has not already been saved (unless this prompt has been turned off under the Preferences 
command, see Section 7.5). Memory allocated by the program is released. 
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9. IMPORTING AND EXPORTING DATA 
(The Edit Menu) 

9.1 Copying Data or a Plot to the Clipboard 

The Copy Table Data and Copy Plot commands can be used to copy a plot or selected data from an existing 
window to the Clipboard. (The Clipboard is an area of memory used to exchange data within and between 
applications.) It can then be pasted into another application, such as a word processor or spreadsheet.  

To copy a plot, bring the desired window to the front by clicking on it or by selecting its name under the 
Windows menu. Then select the Copy Plot command. The plot is placed on the Clipboard as a bitmap 
graphic, which can be pasted into most applications. 

To copy data, it is first necessary to select the cells to be copied. To select a block of data, click the cell at 
one corner of the block, then press Shift and click at the diagonally opposite corner of the block. You can 
also select a block by clicking and dragging the mouse over it. You can select the entire table by choosing 
the Select All command under the Edit menu.  The Copy All Table Data command copies all of the 
information in a table to the clipboard. 

Once a block of data is selected, executing the Copy Table Data command copies it to the Clipboard. The 
table headings may also be copied along with the data, depending on the setting in the Preferences dialog 
(see Section 7.5).  

The Save Tables command provides another way to exchange data with other applications; see Section 8.3. 

The Save Plot Data Points command will save to a file all of the data points used in generating a plot.  The 
first column is the x-axis value, the second column is the y-axis value, and the third column indicates whether 
or not to connect the point with the previous one.  This command is not intended for general use. 

9.2 Pasting Data from the Clipboard 

The Paste command places the contents of the Clipboard into the currently active input cell or edit box. This 
capability can be used to copy individual items, but is most useful in filling in the independent variables in a 
"Specified State Points" or "Saturated Points" table. To paste data into such a table, first click the top-left cell 
of the block into which you wish to place the Clipboard data, then choose Paste from the Edit menu. Entries 
in the same row must be separated by the tab character, and a carriage return character must be used to 
delineate rows. (This is the format used by the REFPROP Copy command, and it is the norm for data copied 
to the Clipboard by most spreadsheet applications.) 

9.3 Inserting and Deleting a Row of Data 

The Insert Row command inserts a blank row into the current table where the cursor is located.   The Delete 
Row command allows a specified row to be permanently removed from the table.  In both cases, the rows 
are not renumbered. These commands are accessible only if a window displaying a table is active.  Clicking 
on a table cell and pressing the delete key will erase the data from that row, but the row itself will remain. 
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10. MANIPULATING DATA TABLES AND PLOTS 
(The Window Menu) 

Each table or plot appears in a separate window and can be accessed, rearranged, or retitled with 
commands in the Window menu. The Window menu contains the three permanent options Tile, Cascade, 
and Retitle. An additional menu item is provided for each table or plot window on the screen. The number of 
windows is limited only by available memory.  

10.1 Arranging Windows on the Screen 

The Tile command resizes and repositions the existing windows so that all are displayed. 

The Cascade command overlaps all of the existing windows so that their title bars are visible, making it easy 
to select any of the windows. 

In addition to the Tile and Cascade commands, windows can be rearranged in the usual fashion by clicking 
and dragging on the title bar. Windows can be resized by clicking and dragging the lower right corner or by 
using the buttons in the top right corner.  

10.2 Renaming Windows 

Each table and plot is provided with a default title when it is generated. These titles are used to identify the 
window(s) acted upon in the Save Tables, Print, New Plot, and Overlay Plot commands. The title of any 
window can be changed by first clicking anywhere in the window or clicking its title under the Window menu 
(to make it the active window) and then clicking on the Rename Window command. A dialog box appears 
listing the current title with an edit box where a new title can be entered. 

 

10.3 Going to a Window 

Any window on the screen can be brought to the front and made the active window by clicking anywhere in 
the window. Alternately, you can click its title under the Window menu. 
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11. THE HELP SYSTEM 
(The Help Menu) 

Help is available under the Help menu. The help system used in REFPROP is a standard implementation 
and works in the manner of most other Windows applications. 

The Help Index command brings up a listing of the main topics in the help system. Click on the item for which 
you would like additional information. You can also access Help from most individual dialog boxes. Pressing 
the F1 key places you in the help system at the point containing instructions for the use of that dialog.  

 

The About REFPROP command brings up the banner that is displayed on the opening screen. 
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Appendix A 
FLUIDS IN THE REFPROP DATABASE 

 
Short Name File Name CAS 

number 
Full Chemical Name EOS Temperature and 

Pressure Limits 
acetone acetone.fld 67-64-1 propanone 178.5-550 K, 700 MPa 
ammonia ammonia.fld 7664-41-7 ammonia 195.495-700 K, 1000 MPa 
argon argon.fld 7440-37-1 argon 83.8058-2000 K, 1000 MPa 
benzene benzene.fld 71-43-2 benzene 278.7-750 K, 500 MPa 
butane butane.fld 106-97-8 n-butane 134.895-575 K, 69 MPa 
butene 1butene.fld 106-98-9 1-butene 87.8-525 K, 70 MPa 
carbon dioxide co2.fld 124-38-9 carbon dioxide 216.592-2000 K, 800 MPa 
carbon monoxide co.fld 630-08-0 carbon monoxide 68.16-500 K, 100 MPa 
carbonyl sulfide cos.fld 463-58-1 carbon oxide sulfide 134.3-650 K, 50 MPa 
cis-butene c2butene.fld 590-18-1 cis-2-butene 134.3-525 K, 50 MPa 
cyclohexane cyclohex.fld 110-82-7 cyclohexane 279.47-700 K, 80 MPa 
cyclopentane cyclopen.fld 287-92-3 cyclopentane 179.72-600 K, 200 MPa 
cyclopropane cyclopro.fld 75-19-4 cyclopropane 273-473 K, 28 MPa 
D4 d4.fld 556-67-2 octamethylcyclotetrasiloxane 300-673 K, 30 MPa 
D5 d5.fld 541-02-6 decamethylcyclopentasiloxane 300-673 K, 30 MPa 
D6 d6.fld 540-97-6 dodecamethylcyclohexasiloxane 270.2-673 K, 30 MPa 
decane decane.fld 124-18-5 decane 243.5-675 K, 800 MPa 
deuterium d2.fld 7782-39-0 deuterium 18.71-423 K, 320 MPa 
dimethyl carbonate dmc.fld 616-38-6 dimethyl ester carbonic acid 277.06-400 K, 60 MPa 
dimethylether dme.fld 115-10-6 methoxymethane 131.65-525 K, 40 MPa 
dodecane c12.fld 112-40-3 dodecane 263.6-700 K, 700 MPa 
ethane ethane.fld 74-84-0 ethane 90.368-675 K, 900 MPa 
ethanol ethanol.fld 64-17-5 ethyl alcohol 250-650 K, 280 MPa 
ethylene ethylene.fld 74-85-1 ethene 103.986-450 K, 300 MPa 
fluorine fluorine.fld 7782-41-4 fluorine 53.4811-300 K, 20 MPa 
heavy water d2o.fld 7789-20-0 deuterium oxide 276.97-800 K, 100 MPa 
helium helium.fld 7440-59-7 helium-4 2.1768-1500 K, 100 MPa 
heptane heptane.fld 142-82-5 heptane 182.55-600 K, 100 MPa 
hexane hexane.fld 110-54-3 hexane 177.83-600 K, 100 MPa 
hydrogen (normal) hydrogen.fld 1333-74-0 hydrogen (normal) 13.957-1000 K, 2000 MPa 
hydrogen sulfide h2s.fld 7783-06-4 hydrogen sulfide 187.7-760 K, 170 MPa 
isobutane isobutan.fld 75-28-5 2-methylpropane 113.73-575 K, 35 MPa 
isobutene ibutene.fld 115-11-7 2-methyl-1-propene 132.4-550 K, 50 MPa 
isohexane ihexane.fld 107-83-5 2-methylpentane 119.6-550 K, 1000 MPa 
isopentane ipentane.fld 78-78-4 2-methylbutane 112.65-500 K, 1000 MPa 
krypton krypton.fld 7439-90-9 krypton 115.775-750 K, 200 MPa 
md2m md2m.fld 141-62-8 decamethyltetrasiloxane 205.2-673 K, 30 MPa 
md3m md3m.fld 141-63-9 dodecamethylpentasiloxane 192-673 K, 30 MPa 
md4m md4m.fld 107-52-8 tetradecamethylhexasiloxane 300-673 K, 30 MPa 
mdm mdm.fld 107-51-7 octamethyltrisiloxane 187.2-673 K, 30 MPa 
methane methane.fld 74-82-8 methane 90.6941-625 K, 1000 MPa 
methanol methanol.fld 67-56-1 methanol 175.61-620 K, 800 MPa 
methyl linoleate mlinolea.fld 112-63-0 methyl (Z,Z)-9,12-octadecadienoate 238.1-1000 K, 50 MPa 
methyl linolenate mlinolen.fld 301-00-8 methyl (Z,Z,Z)-9,12,15-octadecatrienoate 218.65-1000 K, 50 MPa 
methyl oleate moleate.fld 112-62-9 methyl cis-9-octadecenoate 253.47-1000 K, 50 MPa 
methyl palmitate mpalmita.fld 112-39-0 methyl hexadecanoate 242-1000 K, 50 MPa 
methyl stearate mstearat.fld 112-61-8 methyl octadecanoate 311.4- 1000 K, 50 MPa 
methylcyclohexane c1cc6.fld 108-87-2 methylcyclohexane 146.7-600 K, 500 MPa 
MM mm.fld 107-46-0 hexamethyldisiloxane 273-673 K, 30 MPa 
neon neon.fld 7440-01-9 neon 24.556-700 K, 700 MPa 
neopentane neopentn.fld 463-82-1 2,2-dimethylpropane 256.6-550 K, 200 MPa 
nitrogen nitrogen.fld 7727-37-9 nitrogen 63.151-2000 K, 2200 MPa 
nitrogen triflouride nf3.fld 7783-54-2 nitrogen trifluoride 85-500 K, 50 MPa 
nitrous oxide n2o.fld 10024-97-2 dinitrogen monoxide 182.33-525 K, 50 MPa 
nonane nonane.fld 111-84-2 nonane 219.7-600 K, 800 MPa 
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Short Name File Name CAS 

number 
Full Chemical Name EOS Temperature and 

Pressure Limits 
octane octane.fld 111-65-9 octane 216.37-600 K, 100 MPa 
orthohydrogen orthohyd.fld 1333-74-0o orthohydrogen 14.008-1000 K, 2000 MPa 
oxygen oxygen.fld 7782-44-7 oxygen 54.361-2000 K, 82 MPa 
parahydrogen parahyd.fld 1333-74-0p parahydrogen 13.803-1000 K, 2000 MPa 
pentane pentane.fld 109-66-0 pentane 143.47-600 K, 100 MPa 
perfluorobutane c4f10.fld 355-25-9 decafluorobutane 189-500 K, 30 MPa 
perfluoropentane c5f12.fld 678-26-2 dodecafluoropentane 148.36-500 K, 30 MPa 
propane propane.fld 74-98-6 propane 85.525-650 K, 1000 MPa 
propylcyclohexane c3cc6.fld 1678-92-8 n-propylcyclohexane 178.2-650 K, 50 MPa 
propylene propylene.fld 115-07-1 propene 87.953-575 K, 1000 MPa 
propyne propyne.fld 74-99-7 propyne 273-474 K, 32 MPa 
sulfur dioxide so2.fld 7446-09-5 sulfur dioxide 197.7-525 K, 35 MPa 
sulfur hexafluoride sf6.fld 2551-62-4 sulfur hexafluoride 223.56-625 K, 150 MPa 
toluene toluene.fld 108-88-3 methylbenzene 178-700 K, 500 MPa 
trans-butene t2butene.fld 624-64-6 trans-2-butene 167.6-525 K, 50 MPa 
trifluoroiodomethane cf3i.fld 2314-97-8 trifluoroiodomethane 120-420 K, 20 MPa 
water water.fld 7732-18-5 water 273.16-2000 K, 1000 MPa 
xenon xenon.fld 7440-63-3 xenon 161.41-750 K, 700 MPa 
 
R11 r11.fld 75-69-4 trichlorofluoromethane 162.68-625 K, 30 MPa 
R12 r12.fld 75-71-8 dichlorodifluoromethane 116.099-525 K, 200 MPa 
R13 r13.fld 75-72-9 chlorotrifluoromethane 92-403 K, 35 MPa 
R14 r14.fld 75-73-0 tetrafluoromethane 120-623 K, 51 MPa 
R21 r21.fld 75-43-4 dichlorofluoromethane 200-473 K, 138 MPa 
R22 r22.fld 75-45-6 chlorodifluoromethane 115.73-550 K, 60 MPa 
R23 r23.fld 75-46-7 trifluoromethane 118.02-475 K, 120 MPa 
R32 r32.fld 75-10-5 difluoromethane 136.34-435 K, 70 MPa 
R41 r41.fld 593-53-3 fluoromethane 129.82-425 K, 70 MPa 
R113 r113.fld 76-13-1 1,1,2-trichloro-1,2,2-trifluoroethane 236.93-525 K, 200 MPa 
R114 r114.fld 76-14-2 1,2-dichloro-1,1,2,2-tetrafluoroethane 273.15-507 K, 21 MPa 
R115 r115.fld 76-15-3 chloropentafluoroethane 173.75-550 K, 60 MPa 
R116 r116.fld 76-16-4 hexafluoroethane 173.1-425 K, 50 MPa 
R123 r123.fld 306-83-2 2,2-dichloro-1,1,1-trifluoroethane 166-600 K, 40 MPa 
R1234yf r1234yf.fld 754-12-1 2,3,3,3-tetrafluoroprop-1-ene 220-410 K, 30 MPa 
R1234ze r1234ze.fld 1645-83-6 trans-1,3,3,3-tetrafluoropropene 168.62-420 K, 20 MPa 
R124 r124.fld 2837-89-0 1-chloro-1,2,2,2-tetrafluoroethane 120-470 K, 40 MPa 
R125 r125.fld 354-33-6 pentafluoroethane 172.52-500 K, 60 MPa 
R134a r134a.fld 811-97-2 1,1,1,2-tetrafluoroethane 169.85-455 K, 70 MPa 
R141b r141b.fld 1717-00-6 1,1-dichloro-1-fluoroethane 169.68-500 K, 400 MPa 
R142b r142b.fld 75-68-3 1-chloro-1,1-difluoroethane 142.72-470 K, 60 MPa 
R143a r143a.fld 420-46-2 1,1,1-trifluoroethane 161.34-650 K, 100 MPa 
R152a r152a.fld 75-37-6 1,1-difluoroethane 154.56-500 K, 60 MPa 
R161 r161.fld 353-36-6 fluoroethane 130-400 K, 50 MPa 
R218 r218.fld 76-19-7 octafluoropropane 125.45-440 K, 20 MPa 
R227ea r227ea.fld 431-89-0 1,1,1,2,3,3,3-heptafluoropropane 146.35-475 K, 60 MPa 
R236ea r236ea.fld 431-63-0 1,1,1,2,3,3-hexafluoropropane 242-500 K, 60 MPa 
R236fa r236fa.fld 690-39-1 1,1,1,3,3,3-hexafluoropropane 179.52-500 K, 40 MPa 
R245ca r245ca.fld 679-86-7 1,1,2,2,3-pentafluoropropane 200-500 K, 60 MPa 
R245fa r245fa.fld 460-73-1 1,1,1,3,3-pentafluoropropane 171.05-440 K, 200 MPa 
R365mfc r365mfc.fld 406-58-6 1,1,1,3,3-pentafluorobutane 239-500 K, 35 MPa 
RC318 rc318.fld 115-25-3 octafluorocyclobutane 233.35-623 K, 60 MPa 
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PREDEFINED MIXTURES IN THE REFPROP DATABASE 
 
Refrigerants 
ASHRAE   Composition Composition 
Designation Components (mass percentages) (molar fractions) 
    
R401A R22/R152a/R124 53/13/34 0.57885/0.18587/0.23527 
R401B R22/R152a/R124 61/11/28 0.65492/0.15461/0.19047 
R401C R22/R152a/R124 33/15/52 0.38559/0.22945/0.38496 
R402A R125/Propane/R22 60/2/38 0.50766/0.04606/0.44628 
R402B R125/Propane/R22 38/2/60 0.29986/0.04296/0.65719 
R403A Propane/R22/R218 5/75/20 0.10430/0.79785/0.09785 
R403B Propane/R22/R218 5/56/39 0.11708/0.66873/0.21418 
R404A R125/R134a/R143a 44/4/52 0.35782/0.03826/0.60392 
R405A R22/R152a/R142b/RC318 45/7/5.5/42.5 0.58240/0.11860/0.06125/0.23776 
R406A R22/Isobutane/R142b 55/4/41 0.57156/0.06184/0.36660 
R407A R32/R125/R134a 20/40/40 0.34642/0.30032/0.35326 
R407B R32/R125/R134a 10/70/20 0.19787/0.60036/0.20177 
R407C R32/R125/R134a 23/25/52 0.38111/0.17956/0.43933 
R407D R32/R125/R134a 15/15/70 0.26227/0.11368/0.62405 
R407E R32/R125/R134a 25/15/60 0.40261/0.10471/0.49268 
R408A R125/R143a/R22 7/46/47 0.05075/0.47628/0.47297 
R409A R22/R124/R142b 60/25/15 0.67609/0.17848/0.14543 
R409B R22/R124/R142b 65/25/10 0.72671/0.17709/0.09620 
R410A R32/R125 50/50 0.69761/0.30239 
R410B R32/R125 45/55 0.65369/0.34631 
R411A Propylene/R22/R152a 1.5/87.5/11 0.02936/0.83347/0.13717 
R411B Propylene/R22/R152a 3/94/3 0.05922/0.90305/0.03773 
R412A R22/R218/R142b 70/5/25 0.74619/0.02451/0.22930 
R413A R218/R134a/Isobutane 9/88/3 0.04976/0.89658/0.05366 
R414A R22/R124/Isobutane/R142b 51/28.5/4/16.5 0.57172/0.20242/0.06671/0.15915 
R414B R22/R124/Isobutane/R142b 50/39/1.5/9.5 0.58744/0.29031/0.02622/0.09603 
R415A R22/R152a 82/18 0.77678/0.22322 
R415B R22/R152a 25/75 0.20295/0.79705 
R416A R134a/R124/Butane 59/39.5/1.5 0.64718/0.32393/0.02888 
R417A R125/R134a/Butane 46.6/50/3.4 0.41446/0.52310/0.06244 
R418A Propane/R22/R152a 1.5/96/2.5 0.02878/0.93920/0.03202 
R419A R125/R134a/DME 77/19/4 0.70146/0.20360/0.09494 
R420A R134a/R142b 88/12 0.87839/0.12161 
R421A R125/R134a 58/42 0.54001/0.45999 
R421B R125/R134a 85/15 0.82810/0.17190 
R422A R125/R134a/Isobutane 85.1/11.5/3.4 0.80550/0.12804/0.06646 
R422B R125/R134a/Isobutane 55/42/3 0.49729/0.44670/0.05601 
R422C R125/R134a/Isobutane 82/15/3 0.77476/0.16671/0.05853 
R422D R125/R134a/Isobutane 65.1/31.5/3.4 0.59629/0.33940/0.06431 
R423A R134a/R227ea 52.5/47.5 0.64812/0.35188 
R424A R125/R134a/Isobutane/Butane/ 

Isopentane 
50.5/47.9/1/0.6 0.45615/0.49939/0.01679/0.01865/ 

0.00902 
R425A R32/R134a/R227ea 18.5/69.5/12 0.32113/0.61513/0.06373 
R426A R125/R134a/Butane/Isopentane 5.1/93/1.3/0.6 0.04315/0.92568/0.02272/0.00845 
R427A R32/R125/R143a/R134a 15/25/10/50 0.26078/0.18839/0.10762/0.44321 
R428A R125/R143a/Propane/Isobutane 77.5/20/0.6/1.9 0.69433/0.25589/0.01463/0.03515 
R429A Dimethyl ether/R152a/Isobutane 60/10/30 0.66113/0.07685/0.26201 
R430A R152a/Isobutane 76/24 0.73591/0.26409 
R431A Propane/R152a 71/29 0.78574/0.21426 
R432A Propylene/Dimethyl ether 80/20 0.81410/0.18590 
R433A Propylene/Propane 30/70 0.30992/0.69008 
R434A R125/R143a/R134a/Isobutane 63.2/18/16/2.8 0.55678/0.22647/0.16581/0.05094 
R435A Dimethyl ether/R152a 80/20 0.85152/0.14848 
R436A Propane/Isobutane 56/44 0.62653/0.37347 
R436B Propane/Isobutane 52/48 0.58813/0.41187 
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ASHRAE   Composition Composition 
Designation Components (mass percentages) (molar fractions) 
R437A R125/R134a/Butane/Pentane 19.5/78.5/1.4/0.6 0.16850/0.79790/0.02498/0.00862 
R438A R32/R125/R134a/Butane/ 

Isopentane 
8.5/45/44.2/1.7/0.6 0.16191/0.37156/0.42930/0.02899/ 

0.00824 
R500 R12/R152a 73.8/26.2 0.60610/0.39390 
R501 R22/R12 75/25 0.80751/0.19249 
R502 R22/R115 48.8/51.2 0.62999/0.37001 
R503 R23/R13 40.1/59.9 0.49970/0.50030 
R504 R32/R115 48.2/51.8 0.73424/0.26576 
R507A R125/R143a 50/50 0.41184/0.58816 
R508A R23/R116 39/61 0.55758/0.44242 
R508B R23/R116 46/54 0.62675/0.37325 
R509A R22/R218 44/56 0.63079/0.36921 
R510A Dimethyl ether/Isobutane 88/12 0.90246/0.09754 
 
 
 
Natural Gas Mixtures and Air 
Mixture Components Composition 

(Mass Percentages) 
Composition 
(Molar Fractions) 

Air Nitrogen/Argon/Oxygen 75.57/1.27/23.16 0.7812/0.0092/0.2096 
Amarillo Gas methane/nitrogen/ 

CO2/ethane/ 
propane/isobutane/ 
butane/isopentane/ 
pentane/hexane 

82.672/4.9807/ 
1.1696/7.7379/ 
2.0751/0.34255/ 
0.5163/0.13162/ 
0.18165/0.19248 

0.90672/0.031284/ 
0.004676/0.045279/ 
0.00828/0.001037/ 
0.001563/0.000321/ 
0.000443/0.000393 

Ekofisk Gas  methane/nitrogen/ 
CO2/ethane/ 
propane/isobutane/ 
butane/isopentane/ 
pentane 

73.432/1.5028/ 
3.5066/13.605/ 
5.4074/1.0796/ 
1.0858/0.19567/ 
0.18452 

0.85906/0.010068/ 
0.014954/0.084919/ 
0.023015/0.003486/ 
0.003506/0.000509/ 
0.00048 

Gulf Coast 
Gas  

methane/nitrogen/ 
CO2/ethane/ 
propane/isobutane/ 
butane/isopentane/ 
pentane/hexane 

92.176/0.43273/ 
1.5603/3.2551/ 
1.2064/0.33802/ 
0.3484/0.20314/ 
0.13915/0.34061 

0.96522/0.002595/ 
0.005956/0.018186/ 
0.004596/0.000977/ 
0.001007/0.000473/ 
0.000324/0.000664 

High CO2 
and Nitrogen 
Gas 

methane/nitrogen/ 
CO2/ethane/ 
propane/isobutane/ 
butane 

65.706/8.0556/ 
16.835/6.5252/ 
1.9903/0.44261/ 
0.44554 

0.81212/0.05702/ 
0.07585/0.04303/ 
0.00895/0.00151/ 
0.00152 

High 
Nitrogen Gas  

methane/nitrogen/ 
CO2/ethane/ 
propane/isobutane/ 
butane 

70.061/20.227/ 
2.3246/5.3209/ 
1.4306/0.31167/ 
0.32414 

0.81441/0.13465/ 
0.00985/0.033/ 
0.00605/0.001/ 
0.00104 
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Appendix B 
 

USING REFPROP WITH OTHER PROGRAMS 
FORTRAN  SOURCE  CODE 

The subroutines are contained in a number of files, which are placed in the REFPROP\FORTRAN directory.  
The following files should be compiled and linked with your own main program: 

core_anc.for  core_bwr.for   core_cpp.for   core_de.for    core_ecs.for 
core_feq.for  core_mlt.for   core_ph0.for   core_pr.for    core_stn.for    core_qui.for 
flash2.for    flsh_sub.for   idealgas.for   mix_aga8.for   mix_hmx.for 
prop_sub.for  realgas.for    sat_sub.for    setup.for      setup2.for 
trns_ecs.for  trns_tcx.for   trns_vis.for   trnsp.for      utility.for 

These 26 files were compiled with the Lahey compiler using a command similar to this: 

lf95 core_anc.for -c -nco -nom -dll -win -ml msvb 

and linked with the following: 

lf95 pass_ftn.obj setup.obj core_anc.obj core_bwr.obj core_cpp.obj core_de.obj core_ecs.obj 
core_feq.obj core_mlt.obj core_ph0.obj core_qui.obj core_stn.obj core_pr.obj flash2.obj 
flsh_sub.obj idealgas.obj mix_aga8.obj mix_hmx.obj prop_sub.obj realgas.obj sat_sub.obj 
setup2.obj trns_ecs.obj trns_tcx.obj trns_vis.obj trnsp.obj utility.obj   -nco -nom -dll -win -ml msvb -
out refprop.dll 

There is one additional file that comes with REFPROP.  This file, called pass_ftn.for, is used only when 
creating the DLL. 

Several example files showing how to call the routines are located in your REFPROP\Examples directory.  
EXAMPLE.FOR shows the common routines that you might need.  EX-MIX.FOR shows how to load a 
mixture .MIX file containing information for specified blends of refrigerants (and air).  The file EX-PPF.FOR 
shows how to use the pseudo-pure fluid files. 

In version 8.0, any fluids that are used must have a ".fld" extension, e.g., R134a.fld, or a ".ppf" extension, 
e.g., air.ppf.  In 8.1 and later versions, the .fld extension is no longer needed and assumed if missing.  The 
file HMX.BNC (containing mixture parameters) must also be present.  It is suggested (but not required) that 
these be put into a subdirectory called "fluids" under the directory containing the subroutines and application 
program. 

The subroutine SETUP must be called to initialize the pure fluid or mixture components.  The call to SETUP 
will allow the choice of one of three standard reference states for entropy and enthalpy and will automatically 
load the NIST-recommended models for the components as well as mixing rules.  The routine SETMOD 
allows the specification of other models.  To define another reference state, or to apply one of the standard 
states to a mixture of a specified composition, the subroutine SETREF may be used.  These additional 
routines should be called only if the fluids and/or models (or reference state) are changed.  The sequence is: 

call SETMOD    (optional) 
call SETUP     (REQUIRED)         [or call SETMIX] 
call SETKTV    (optional) 
call SETREF    (optional) 

Subroutine SETUP0 calls subroutine SETUP using the same techniques as those used by the graphical 
interface and the Excel spreadsheet.  Subroutine SETMIX reads the *.MIX files and makes the appropriate 
call to subroutine SETUP.  Subroutine SETPATH sets the path where the *.fld files can be found.  Subroutine 
PUREFLD allows the user to calculate the properties of a pure fluid when a mixture has been loaded and the 
fluid is one of the constituents in the mixture. 

Note:  The only exceptions to the above are the conversion utilities XMASS and XMOLE.  The graphical 
interface allows a wide variety of units, but not the subroutines. 
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B.1 Units 

All inputs and outputs to the subroutines are in the following units: 

temperature K 
pressure, fugacity kPa 
density mol/L 
composition mole fraction 
quality mole basis  
    (except mass basis allowed when quality is input) 
enthalpy, internal energy J/mol 
Gibbs, Helmholtz free energy J/mol 
entropy, heat capacity J/(mol⋅K) 
speed of sound m/s 
Joule-Thompson coefficient K/kPa 
d(p)/d(rho) kPa⋅L/mol 
d2(p)/d(rho)2 kPa⋅(L/mol)2 
viscosity μPa⋅s (10–6 Pa⋅s) 
thermal conductivity W/(m⋅K) 
dipole moment  debye 
surface tension N/m 

Note:  The only exceptions to the above are the conversion utilities XMASS and XMOLE.  The graphical 
interface allows a wide variety of units, but not the subroutines. 

B.2 Naming Conventions  

The variable type of subroutine arguments can generally be inferred from the first letter of the variable name: 

a-g and o-z: double precision 
h: double precision (i.e. enthalpy) or character 
i-k and m,n: integer 
l: logical (within subroutines only, no logicals are used in arguments) also used as integer 

for exponent of FEQ model 

The property subroutines are compatible with FORTRAN 90. The routines are largely compatible with ANSI 
standard FORTRAN 77; the only extension widely used is the "do – enddo" construct, which is supported by 
most FORTRAN 77 compilers. We are striving to make these subroutines as standard and portable as 
possible, but every compiler has its own sensitive points. Please report any compiler or linker errors or 
warnings. 

The fluid data files are read using logical unit 12. Use of this unit in your application may crash the program 
and should be avoided. 

The file MANUAL.TXT located in your REFPROP\FORTRAN directory contains a description of the high-
level subroutines that would be used in stand-alone applications. These subroutines will give you access to 
all features in a model-independent fashion. (There are corresponding low-level subroutines for some of 
these that call specific models. Please do not incorporate the low-level subroutines into your applications—if 
you do, you may find that future versions may not work the same.) 

B.3 Excel Spreadsheets 

The REFPROP software includes dynamic link library ('.dll') support that allows a broad variety of 
applications to take advantage of REFPROP's capabilities.  REFPROP is distributed with front-end software 
that links Microsoft Excel applications to fluid property functions. 
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The REFPROP Excel front-end is supplied as a Microsoft Visual Basic module.  Excel automatically 
incorporates Visual Basic as a macrofunction execution, scripting and interface utility.  When the REFPROP 
front-end module is imported into an Excel spreadsheet, REFPROP functions become accessible to the 
user.  The procedure for doing this is described below. 

The information given below demonstrates the front end usage; however, the user is not bound to this 
format; rather, the preferred method would be to write one's own visual basic code that calls the DLL directly.  
A dedicated module will increase the speed of the application and give the ability to use the REFPROP 
functions to their fullest. 

The following supplementary instructions are intended for users who wish to create and modify their own 
spreadsheets that utilize the REFPROP functions based on the front-end module.  The Excel application 
included with the software is called REFPROP.xls and is located in the directory where the REFPROP 
program was installed.  Sample FORTRAN and Visual Basic files are also included. 

Properties are calculated by calling various functions.  For example, the following line would be placed in a 
cell to calculate the density of argon at 300 K and 10 MPa: 

=Density("argon","TP","SI",300,10) 

Other properties can be calculated by using any of the following functions: 

Temperature IsentropicExpansionCoef 
Pressure IsothermalCompressibility 
Density VolumeExpansivity 
CompressibilityFactor AdiabaticCompressibility 
LiquidDensity AdiabaticBulkModulus 
VaporDensity IsothermalExpansionCoef 
Volume IsothermalBulkModulus 
Energy Viscosity 
Enthalpy ThermalConductivity 
Entropy Prandtl 
IsochoricHeatCapacity (or Cv) SurfaceTension 
IsobaricHeatCapacity (or Cp) DielectricConstant 
SpeedOfSound (or Sound) MoleFraction 
Quality MassFraction 
HeatOfVaporization (or LatentHeat) LiquidMoleFraction 
JouleThompson VaporMoleFraction 
MolarMass Mole2Mass 
EOSMax Mass2Mole 
EOSMin dPdrho 
d2Pdrho2 dPdT 
drhodT Cstar (critical flow factor) 
SpecificHeatInput Fugacity 
FugacityCoefficient Chemical Potential 
Activity ActivityCoefficient 

 

The first input in the call to the function is the pure fluid name or mixture string.  The file name located in the 
fluids directory where REFPROP was installed should be used as the fluid name (without the .fld extension). 

For mixtures, the fluid names and compositions (in mole fractions) of the constituents in the mixture are 
placed in a single cell as in the following example for dry air: 

nitrogen;0.7812;argon;0.0092;oxygen;0.2096 

A more convenient way is to use the FluidString phrase to join multiple cells: 
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=FluidString(A1:A3,B1:B3) 

where the fluid names are stored in A1, A2, and A3, and the mole fractions are stored in B1, B2, and B3.  
The stored mixture files (*.MIX) can also be read by simply replacing the fluid name with the name of the 
mixture file: 

=Enthalpy("R410A.MIX","TD","molar SI",300,5) 

The second input to the function is the combination of input properties being sent to the function.  Thus, for a 
given pressure and temperature, the second input would be "PT" (or "TP", depending on the order in which 
the properties are sent).  Other valid inputs include the density (D), energy (E), enthalpy (H), entropy (S), and 
quality (Q).  Valid combinations include: TP, TD, TH, TS, TE, TQ, PD, PH, PS, PE, PQ, DH, DS, DE, and HS.  
For saturation states, the second input is Tliq or Tvap for a given saturated temperature, Pliq or Pvap for a 
given saturated pressure, or Dliq or Dvap for a saturated density.  Liquid properties are returned when these 
inputs contain "liq" and vapor properties are returned when "vap" is used. 

The third input to the property functions defines the units.  This input can be one of the following:  "SI", "SI 
with C", "Molar SI", "E", "cgs", "mks", "M".  If left blank, the default is SI.  The "SI with C" input can be shorted 
to just "C".  The units that correspond to these inputs are: 

SI: K, MPa, kg/m^3, kJ/kg, kJ/kg-K, m/s, uPa-s, mW/m-K, mN/m 
SI with C: C, MPa, kg/m^3, kJ/kg, kJ/kg-K, m/s, uPa-s, mW/m-K, mN/m 
Molar SI: K, MPa, mol/dm^3, J/mol, J/mol-K, m/s, uPa-s, mW/m-K, mN/m 
mks: K, kPa, kg/m^3, kJ/kg, kJ/kg-K, m/s, uPa-s, W/m-K, mN/m 
cgs: K, MPa, g/cm^3, J/g, J/g-K, cm/s, uPa-s, mW/m-K, dyn/cm 
E: F, psia, lbm/ft^3, Btu/lbm, Btu/lbm-R, ft/s, lbm/ft-s, Btu/h-ft-F, lbf/ft 
M: K, psia, g/cm^3, J/g, J/g-K, m/s, uPa-s, mW/m-K, mN/m 

For example, the following line would be placed in a cell to calculate the density of argon at 100 F and 250 
psia (the result will be in units of lbm/ft^3): 

=Density("argon","TP","E",100,250) 

The independent variables in the equations of state used in REFPROP are temperature and density.  If more 
than one property is needed, it is best to first determine these quantities from the given set of initial inputs, 
and then determine the other properties.  This will greatly speed-up the calculation.  This is particularly 
important when properties for pure fluids that are within the two-phase region are calculated.  For example, 
to calculate the energy, enthalpy, and entropy given the pressure and quality of a two-phase system, place 
the fluid name in cell A1, the pressure in B1, and the quality in C1.  Put the following in cells A2 through A5: 

=Temperature($A$1,"PQ","SI",$B$1,$C$1) 
=Density($A$1,"PQ","SI",$B$1,$C$1) 
=Energy($A$1,"TD","SI",$A$2,$A$3) 
=Enthalpy($A$1,"TD","SI",$A$2,$A$3) 
=Entropy($A$1,"TD","SI",$A$2,$A$3) 

The functions LiquidDensity and VaporDensity will return the saturated liquid and vapor densities of a two-
phase state.  These densities, along with the temperature, can then be used to calculate all other 
thermodynamic and transport properties at the saturation boundaries using the functions outlined above. 

The inputs "Tmelt", "Pmelt", "Tsubl", and "Psubl" return melting line or sublimation line values.  To calculate 
the melting pressure for argon at 90 K, enter: 

=Pressure("argon","Tmelt","SI",90) 

To calculate the melting temperature, enter "Pmelt" as the second input and the melting pressure as the 
fourth input. 
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=Temperature("argon","Pmelt","SI",25) 

The critical point or triple point is returned in a similar manner via the inputs "crit" or "trip", along with inputs of 
the fluid name and the units.  The molar mass (molecular weight) is returned using the function MolarMass 
with an input of the fluid name only.  All of these functions are shown in the REFPROP.xls file. 

REFPROP can be permanently linked to EXCEL by following these steps: 

(This documentation assumes that the REFPROP files have been installed in the "C:\Program 
Files\REFPROP" directory.  Other installations require appropriate adjustments.) 

First, execute either step #1 or step #2 (#1 is preferred): 

1.  Two environment variables can be set to specify the locations of the fluid files and the DLL.  This can be 
done under Start/Settings/Control Panel/System/Advanced/Environment Variables.  A new variable called 
RPprefix should be created with a value of "C:\Program Files\Refprop" (or the directory where Refprop is 
located).  If the Path variable does not exist, create one and add the same directory as you did for RPprefix.  
If the path variable does exist, it should be modified by adding ";c:\program files\REFPROP" to the end so 
that the REFPROP.DLL file can be found from any location.  Screen shots and updated information are given 
on the REFPROP FAQ webpage. 

2.  From EXCEL open the file REFPROP.xls.  Open the VB-editor with 'Alt-F11'.  Scroll to the top of the 
module and read the comments.   Make the necessary directory changes as described.   The lines should 
look like this: 

. 

. 
Public Const FluidsDirectory As String =  "c:\program files\refprop\fluids\" 
Public Const MixturesDirectory As String = "c:\program files\refprop\mixtures\" 
. 
. 

The path marked "c:\..." must point exactly to the location where the REFPROP fluid and mixture files are 
stored on the user's disk drive.  Scroll down several pages and follow the instructions about specifying the 
path for the Refprop DLL by replacing all occurrences of "Refprop.DLL" with "C:\Program 
Files\Refprop\Refprop.DLL".  Quit the VB-editor and return to EXCEL and save REFPROP.xls. 

3.  Save the REFPROP.xls file as a Microsoft Excel Add-In (named REFPROP.xla).  The default location will 
appear as something like ...\Microsoft\AddIns.  The file should be saved in this directory.   Alternatively, do a 
search on your computer for the *.xla files and put the REFPROP.xla file in with the others. 

4.  Open EXCEL with an empty spreadsheet and find under 'Tools' the Add-Ins Manager. Find on the list of 
available Add-Ins the new entry 'REFPROP AddIns'. Mark it as active and exit the Add-Ins Manager. 

5. Now open any EXCEL spreadsheet, go to any cell and type something like: 

=density("water","TP","SI",500,100) 

6.  If you need to edit the .xla file after it has been installed, reopen the REFPROP.xls file, edit the VB 
section, then save it as .xls.  Under 'Tools' go to the Add-Ins Manager and deselect the REFPROP AddIn.  
Then save the file again as .xla. 

7.  Once the module has been imported into a spreadsheet, the REFPROP functions may be selected by 
using the pull-down function list.  When editing the formula in a cell, select More Functions from the pull-
down list and scroll down the Function Category list to select the User Defined functions.  The argument 
editor will prompt for REFPROP function arguments as it does for standard Excel functions. 
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B.4 Visual Basic Applications 

Sample Visual Basic (VB) code is provided that demonstrates the use of VB with REFPROP.  The file is 
called Sample.bas and is located in the Examples directory where the REFPROP program was installed.  It 
uses the dynamic link library REFPROP.DLL.  Sample FORTRAN and Excel files are also included. 

VB subroutines analogous to all of the FORTRAN subroutines are available. The subroutine names have 'dll' 
appended to the FORTRAN names (for example, SETUPdll is the VB analog to the FORTRAN subroutine 
SETUP). The inputs and outputs are the same as the FORTRAN routines, except that additional arguments 
specifying the length of any string variables are required. 

The file Sample.bas consists of subroutine and variable declarations in the first part of the file. These 
declarations would be necessary for any program. The latter part of the file provides examples of calling the 
various subroutines. No output is displayed when the program is run because it is intended only to show how 
the calling routines work.  Comments are given throughout the code describing the various calls and 
procedures.  Additional details on the subroutines and functions are given in the FORTRAN code included 
with REFPROP. 

B.5 Sample C Code 

The example C code, called EX_C1.CPP (located in the CPP.Zip file), uses explicit (sometimes called late) 
linking for the functions in the DLL.  All functions exported by the DLL have been provided in the header file, 
REFPROP1.h, for completeness.  All functions exported by REFPROP are in the file PASS_FTN.FOR 
located the REFPROP\FORTRAN directory.  This sample code was tested with the Microsoft Visual C++ 
compiler in Visual Studio 2003 (Microsoft 32-bit C/C++ Compiler Version 13.10.3077).  The main issues in 
mixed-language code compiling are function naming conventions, argument passing, and stack 
maintenance.  Explicit calling of the FORTRAN functions in the DLL allows one to define a function pointer 
name explicitly.  The _stdcall keyword on the function prototype lets the compiler know how arguments will 
be passed and which side is responsible for cleaning the stack after the function call. 

B.6 Sample MATLAB Code 

A sample MATLAB file, called refpropm.f90 (located in the MATLAB.Zip file), is available to help software 
developers link MATLAB with the routines used in REFPROP.  The file is located in the directory where the 
REFPROP program was installed.  Sample Visual Basic code and Excel spreadsheets are also included.  
New versions of the MATLAB routines are available on the REFPROP FAQ web site. 

The program was written by Lennart Vamling at the Chalmers University of Technology in Sweden and 
modified by Johannes Lux of the German Aerospace Center and is only intended to show how the calling 
routines work.  To quickly test the sample program: 

1) The REFPROP fluids directory should be located in "C:\Program Files\REFPROP\fluids". 

2) The MATLAB path should include the directory where "refpropm.mexw32", "refpropm.m" and the fluid 
specific files reside. 

Otherwise, if the fluids directory is in a different location, one line in the "refpropm.f90" file has to be changed, 
and it must be recompiled using the MATLAB mex command. MATLAB must then be configured to work with 
a suitable FORTRAN compiler. The REFPROP subroutines must also be referenced in the mex command. 

With the \REFPROP\MATLAB directory as the current working directory, issue the following command in 
MATLAB to reference the REFPROP subroutines: 

mex refpropm.f90 ..\fortran\*.for 
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The REFPROP library for MATLAB was compiled with the version R2006b. Because Mathworks has 
changed the file extension of external files from .mex to .mexw32 (for 32 bit windows systems), the new 
interface will not work with MATLAB 6.5. Also, the file refpropm.mexw32 is required to run the interface. 

The additional file refpropm.m is only for the help function of MATLAB.  If you type "help refpropm", you will 
see the content of the refpropm.m file. 

Some users of the old interface experienced that the first call gave strange answers, but if they repeated 
exactly the same call, the second gave the correct result.  This effect seems to be tied to the 6.5 compiler 
and is no longer an issue when using the 2006 MATLAB program. 

New versions of the MatLab routines are available on the REFPROP FAQ web site. 

B.7 Warning and Error Messages 

The FORTRAN routines return warning and error codes and messages when the input conditions are out of 
range or the calculations fail. The error codes are integers returned in the subroutine argument ierr. When a 
calculation is successful, the value of ierr is 0. Negative values of ierr signify a warning—that is, a condition 
where calculations were completed, but the results may be suspect. The most common warning would be for 
a temperature or pressure slightly above the limits of the property model. 

Errors imply conditions for which the calculations failed (such as an iteration not converging) or for which 
calculations are not possible (such as a negative pressure or a mixture composition not summing to one). 
Many property models give nonsensical results when extrapolated to lower temperatures and/or higher 
densities; thus errors are also issued when the temperature is below the limit of the model or the density is 
above the limit. The codes for errors are positive numbers. 

More detailed messages (including, in some cases, a report of the input condition(s) that resulted in the 
warning or error) are available via the output variable herr, which may be printed or displayed using the 
subroutine ERRMSG. In the graphical interface, errors are displayed in an Alert box. If the calculation of a 
table results in a warning, a message is displayed at the completion of the calculations, and the individual 
messages can be displayed by clicking the mouse on the number of the affected row. 
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Appendix C 
 

CONTACTS 

If you have comments or questions about the database, the Standard Reference Data Program would like to 
hear from you. You can rate the program and give feedback for future development at the following website: 

http://tsapps.nist.gov/msdsurvey/default.aspx?ID=1 

Also, if you should have any problems with the CDs, installation, or downloading the installation program, 
please contact: 

 Joan Sauerwein 
 Standard Reference Data, MS 2300 
 National Institute of Standards and Technology 
 Gaithersburg, MD 20899-2300 
 (301) 975-2208 
 (301) 926-0416 (FAX)* 
 Joan.Sauerwein@nist.gov 

The scientific contacts for the database are: 

Thermodynamic properties, graphical interface, and Excel spreadsheets: 
 Eric W. Lemmon 
 Thermophysical Properties Division 
 National Institute of Standards and Technology 
 Boulder, CO 80305-3337 
 (303) 497-7939 
 Eric.Lemmon@nist.gov 

Transport properties: 
 Marcia L. Huber 
 Thermophysical Properties Division 
 National Institute of Standards and Technology 
 Boulder, CO 80305-3337 
 (303) 497-5252 
 Marcia.Huber@nist.gov 


